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https://tug.org/texworks/ (TeX Live©l Z3g})
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« TeXnicCenter (Windows):
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1.1.3 7| A] F7}517]

olzf) AL tjBEE ] GNU/Linuxoll L= 0] Y= TeX A ARl TeX Liveol A-&Hch,
MacTeXo A= §&3s 7o)X gt Wat= Linuxol © 2<3ict. 714 8335 Windows
i 2239l MiKTeX& 913t 2132 2 Aol =7t
o9 w2 BIpX T 7] 2|7} 7| 24 0 2 Alg-Hrt. olE £ dv|Qt 7|¥ke] GNU/Linux
HHsTai%% texlive- E}i ol &9 W mi7| A& ZEF1L ITh( 7|4 w7 A2k & A2
ot 2 0 2 KIEX 7| |9t 25514 FEE gt
o7k thd thg AAE w2},

l:o

$ mkdir -p ~/texmf/tex/latex

o] Tielele] okl A} W] 2| & Mg},

2. 71712 CTAN v 28 € 117]2] & the2 25t} thAl 2 zip O 2 A& H HE 2
2 Zojt}t, o] A4S foo.zipolet 27| 2 1A},

3. A% %00 &S Eeh,

$ mkdir ~/texmf/tex/latex/foo
$ mv foo.zip ~/texmf/tex/latex/foo

$ cd ~/texmf/tex/latex/foo ; unzip foo.zip
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E47] Ctrl-X Ctrl-C :qa! Ctrl-KXx
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AEAjI517]
AZ 3+ FA¢ Ctrl-H X BS
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Az Ctrl-A Ctrl-K dd Ctri-Y
7] & HFE]
27 Ctrl-S text /text Ctrl-Qs
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$ texhash ~/texmf

MiKTEX A 31712 & 27152 ¥ MiKTEX console o] B &3-S o] &5t}

\latex\newpackage & E| 2] 5 C:\localtexmf\tex\ of2foll T3 B %t o}
22 of7|o| 7}11:} o}, Yol A3t xS w2 thg MiKTeX Options S Ag¥sto] ~
‘Refresh now’ HES FErF = initexmf -u HHS HFGol|A APstct o]Ao

0l

Ao

At 5727} A 2] H Fofl= \documentclass A o]Fof t}2 32 0 ZH AHAI
of Mol &8 4 SUck.
\usepackage{foo}

1.1.4 Info H|o]A] 7}
‘man’Y} ‘info’ H|O|A| = AZEQo]o] M EAE P JE|Ho| A2 A Fdl= ;‘JQE
UnixU GNU/Linux A| 280l A &3] AL & &ME}. Rk
#jo] 917 ek o thg 3t o) aal,
1 oS oz ERt
https://tug.ctan.org/info/latex2e-help-texinfo/latex2e.info;

latex2e.info

$ gzip latex2e.info

$ sudo cp latex2e.info.gz /usr/share/info/

$ sudo ginstall-info latex2e.info dir

ol#] info latex2e WO = info ZAE S 5

12 24 Aol $38
FoEG o= *]"_%]'% g i of ghct.
e —E—/ﬂ% H (part) - %} (chapter) -

+ wi7hoh2h=

20|}, ZHalo] o} 721 & of of 7|31
0] 724 07| Zo] that vhgol

e =2 W27 ENAE

(53547 2| Unix TeX Live Al AE10f|A
~/texmf = TEXMFHOMEO|2t= A 2=0f|
stete|of QUCt. w2t HE 2 texhashlt
mktexlsrg *e"’oHOf | QO EICH AJAE
2| X2 M TEXMFLOCAL (%[0 22
IH7 | XS X[ E mof= o] FHE | MHO|
ZQstCt.

o] 2Etojl M MEBHE MiKTEX 4
H*EQ Z= Ol HH 2 flet Aolch 2023E|

E
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File ¥+

File[>Save(*%5}7]), File[>Close(27]) &< ol|t]E]9] 7|5o|t}.

2.1 File>New (A T}+¥)

CEEE

mjo]7) shpg RhE s FE s ohe a2,

9= mR Aol A o] Wi Mt ¥l ol x| slutE HolETh, KXo 2 ¥l

\documentclass{article}
\thispagestyle{empty} % Lf|0|Z| HHS A|A

\begin{document}
% 0] HE2 =AM (comment). 27} MELCt.
\end{document}

BRX o2 443 BAL Rador 3z o)ty 23 o A2 olAlg ¥

\documentclass[adpaper,12pt]{article}
\begin{document}

\title{My Document}

\author{John Smith}

\date{London,\today}

\maketitle

\begin{abstract}

This is a very short article.

\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\section{First Section}

\label{sec:start}

This is the text of the section. See \cite{Gonzato} for details.
\section{End}

\label{sec:end}

This is the end of the document. Please go to Section
\ref{sec:start} to read it again.
\begin{thebibliography}{99}

\bibitem{Gonzato} Gonzato G. \textit{\LaTeX{} for Word Processor
Users}. CTAN,2001--2023.

\end{thebibliography}

\end{document}

20| Aol o B 4 Eglo] nlaiEo] i},

2.2 File[>Save As...(t}2 2|0 2 #7F})

BEX £48 T2 000 2 Wek A 8 o) A8 4 9l RSl

« TEX4ht= BIEX-S HTML/XMLZ #1357 9k 2]de] =2 38 Zolct, °
https://tug.org/tex4ht

[
Al
=

HFTeX Liveofl el Iwarp2hs TH7| X &

HE 2 I}
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https://tug.org/tex4ht

« HTMLZ ¥&3}17] 93l latex2htm|S o] 88 % t},
CTAN://latex2html

« latex2rtf= RTF (Rich Text Format) 2 ¥ttt
CTAN://latex2rtf

o detex (3 §187]) = BIEX Bl L& A7 sto] Z29 HAE & s Eo.
https://github.com/pkubowicz/opendetex,
CTAN://detex/

71231 Pandocol2h= 20| Rltt. o] 2 I3 of thsi M= E | 2 Folisto]
ARgstaltt. 2.4742 ¢lo| 7] vldt}. PDF A2t} n] 2 2 7]of ohgh A2 2.6 S Het

2.3 File[>Save As Template(]Z3 22 %)

BEX ‘W E 300l eh 2ol M2 e BEX 17128 BhEs A
2 W9 oA Be Exlo|tt,
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2.4 File>Import(E°127])

Pandoc &50]#| https://pandoc.orgol ot} 22 uj-go| it}
oh3y] Eefo] updS o2 Zof o 2 Wgtsle $obH pandoco] THs £ 67F (S leat 7101 2t (swiss army knife)
Htt.
Pandoc2 BIEX £A1E A/35ke 2838 fig7|oln, 2 7otk %] 7] b=t} thst
Zofo] BN E 2L HMStshe o] W4l 2 asjolot,
Pandoc®] 7|2 EZ 92 Markdown &7oltt, o] xujo 2 HE KX o= o] M
£ o] Foj Rt o] & S0] B}, th2of Ho|= A2 Markdown O 2 ZHAJ 5 FA{o|t},

title: |

This is the title: \

now write the rest
author: Guido Gonzato
date: August 2023
abstract: |

This is the abstract.
<!--- This is a comment. -->
[comment]: # (This too is a comment)
# Section
This is **bold text**,this is *emphasized text*,this is normal text.
If you're bored,go to [The End].

## Subsection

This is “verbatim text'.

6 FILE %+


https://www.ctan.org/pkg/latex2html
https://www.ctan.org/pkg/latex2rtf
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# The End

My dad used to say:

> Damn,Pandoc has not been invented yet!
but not it has.

<l--- end of pandoc_ template.md -->

o

o] A= Antd 7153 BIEX AA R vl W o2 HeS )

pandoc -s pandoc_template.md -o pandoc_template.tex

EEXS 712 o] AAE A4 PDFE 45t W ofe ¥ Yo

pandoc --toc \

-V urlcolor=blue -V toccolor=red \

-V geometry:margin=2cm \
pandoc_template.md -o pandoc template.pdf

-V RO AZFShE 2 S-S A5 Aoltt. Mgt A2 Pandoc AH A& Bt
Pandoc& o] &35l t}aFst L] BAE BIpX o2 HEE 4 Qith, 2 74| ol &
SolE 7o

$ pandoc -s index.html -o index.tex
$ pandoc -s text.docx -o text.tex

$ pandoc -s text2.rtf -o text2.tex

..and so on.

-5 Zeh 1t “standalone”®] oujo|c}, % 22 w2 YT WEX £A7F Bk ol

Markdownol|A #2413} k=
o] 272 2}7} 271940}, Markdownoll= ofe] 850l 913 24} 4Bt 7)) 224
2}, 45k2 9] 2] Yol ZF Markdown AFgotct k7t 2fe]7} Ql+=H, pandoc Markdown
= 71802 342 thg 3} o] A 2sitt
« PZ(in-line) AL $2 AZSI § 2 BUTH =
o|Ao|t},
- 3 (displayed) 2412 $$ BT} $$ 3 Atooll Hojd=

o

of 23

fol

5 2409

i

=$7

ol

9% 4419) 2ol 5,9} 2ol Ano] 22 Butoh ki A wlo] ol A 2ol ORF 502 Markdownol W Jfee]
SHLFR! 2

o £R& 78 4 e, Waole] TAL 9ol olola] nholch, Eolspl Eag L% Mullimarkdown \\ (51 \)

%% 44/ Yol e polof gk £AI7E ek, ZAHE \\) F100 icko] 2 200l S5,

2] & 4418 Mok Sk amsmath 2] <aligned>2}F 20| <equation> WHollA & 4=

3= Markdown 241 & 24T of o0& M2 koTpX TH7| A& 2 E5H| 8H= Aot}

title: A=
author: A At
header-includes: |

2.4 FILED>IMPORT(E0{27]) /



\usepackage{kotex}

ook XalTEX ZHut o] & 23ttt PandocS A3y e uf th-3-3F 20| --pdf-engine
S4E Folof g}

$ pandoc --pdf-engine=xelatex -s -t latex mywork.md -o mywork.tex

B E Bo|| k= Markdown &A1& 2Hdstal A 2]5t= A E2 B}

2.5 File[>Page Setup(zl|°|A] 2A)

|2 27], A FEF, oS HAA5t= LRby HR-2 \documentclassoll &4 Thato]
E FE=7lo|t}. £4] A7]|= adpaper, a5paper, b5paper, letterpaper, legalpaper,
executivepaper 59 stUE | Aottt B2 portrait”?t 71290 d|, landscapes

ofstol 7427k 2] §A17 HEE v 4 9k, oS 59 thea} 2.

\documentclass[a5paper, landscape,12pt]{article}

[ 29 X‘Mf._ counter2} dimension
o9 R0l 21X nhale W0z HAE Ha10 W Aol sLoplo] S 220 PEIX 41, IRi0lE S
A HA| o] AF vpRl2 \setlength §g o= gt} o] -2 H4el 712-E 9] ATBA “IH2E" 2t X| A5k QI O

1o S 8 T Sl = Mylxz 20N 822 102 87|, 0|22

&hS vk AR8shE Aol geometry 7141 E o §ot= o) B T of #7171 B 71 2E{0] chstAfBt 712 Efekn

o] &5t &A| Afo]=, mhRl Zo|ef 22 uitn|E Bl g2l et HofotLt,

o= Y2 e Melirlglo] QlojA] o 7)o tf AT 4= Qi Ti7|A] EAE QlojRE S

H3tct, ot oo A3 AFERS o EQl=d €5 getu| g = T2 A FAo AFEE

2 e 7ol glon, &) o & 57] sl Bl A= ot
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)
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% memoir/oblivoir A= geometry
of= CHE WAlo| ZaiA XAl H|O| X
{|0]0F A7 20| ULE. oblivoir 7t
\usepackage{geometry} % top of document X2 5t= fapapersize TH7 | X| & 2HHSHH &
e = QUL IH7|X| 2ME & 05}2}. geometry
\geometry{paperwidth=25cm} 7} memoir/oblivoirOllA S22 Y27 |X|=

. ot=Zio2 U QoL SeiA KK X
\geometry{paperheight=35cm} MR TS Ao AFR S A= Qirh
% or: \geometry{papersize={25cm,35cm}}
\geometry{width=20cm} % total width
\geometry{heigth=30cm} % total heigth
% or: \geometry{total={20cm,30cm}}
\geometry{textwidth=18cm} % width - marginpar
\geometry{textheight=25cm} % heigth - header - footer
% or: \geometry{body={18cm,25cm}}
\geometry{left=3cm} % left margin
\geometry{right=1.5cm} % right margin
% or: \geometry{hmargin={3cm,1.5cm}}
\geometry{top=2cm} % top margin
\geometry{bottom=3cm} % bottom margin
% or: \geometry{vmargin={2cm,3cm}}
\geometry{marginparwidth=2cm}
\geometry{head=1cm} % header space

at}

\geometry B thil thZ2d f7|A] FHES F= = Ao

\usepackage[left=3cm, right=2cm] {geometry}
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https://www.ctan.org/pkg/geometry

2.5.1 Page Setup[>Headers and Footers(}slc HF)
fancyhdr H7| A & AL&-5}H \pagestyle{fancy}at= HH S & 4 JA Boh. 0 24
o] A hol] &l  — book.clsztH #(chapter) — & dHF+= FTHAFe} 5hctof mo]A]
WS el ShEmE g Al o mopo 2 phsol 2t Aottt Mg AL Al stoke
Aw 7hssith, 2t iF Jod e 9%, Thed, 2% A REo R LAshey), 7 B
A% 3, shed ¥, 2% Yo| 22t Mg Wt b BN S B

\usepackage{fancyhdr}

\lhead{} % empty

\chead{Hello,world!}

\rhead{Page \thepage} % page number

\lfoot{}

\cfoot{\textbf{Hello!}}

\rfoot{}
2.6 File>Print Preview (&3 n|g|17])
U FEu st pdflatex ==+ xelatex, lualatex 2 PDF TS HERE THE-0]A] 2}4l 0]

£7] 2= PDF R|2| 27| A4S A¥gstd Hr},

hyperrefo]t} url 22 sj7| A & 2H B2} 74535 PDF otd 2 BHET o]9
A= 41882 Heb ey pdflatexoll Al A5 H71 A& AHSE of 2418 He &
U, 12 o] ok AT 2hA IS AL 4.14 0l A Th2 T

2.7 File>Print(4})

ZHil o] Ab&-5al Q1= PDF v] gl 7] 19| w0l File[>Print &%-0] 9l& ZAoltt

2.8 File[>Versions(H{A &)

H7 o]y Tt 35 LS st =2 alo] W 71| Qlt}. old AU & AS 5=

ZAFE A27HE RCSE2 T A2 2 ol o= AT 2R o FX Festa
Z AFEAFS A Y 5H= Subversion, Git, Mercurial Z+2 =17} . W}, Gito] 71 o]

AFGEIE 2Rl BEX 8 Telo] BejAl s ohe BAE Fustet.

o https://www.desy.de/~bargheer/gitintro/git.html

(%19 e moir/oblivoirofl A= fancyhdr
Qb= C}Z gtAlo| ZafA XHA| ‘H|0|X|
AERY MH HEAIO| QICE fancyhdr®f
SEE UK Y= AR AB K
QlOLt SefA Q| MM utAl 3 S A|of At
£ giCh

EF 10| om0l M & Z3H= HHOI GllAIE
OiIT fancyheading | Z40|C}. ¢4xH <]
fancyhdr O HE 2 X507 | = ot
EI=Z \fancyhead, \fancyfoot
FPO = dYst= 20| ELf. B9 LH

Z2ME CIXfolEt mjof] a1 2{stCt,

|
x|et

-
[ofz1

IXXH= Eps D8 AQlS
Aoz E‘J'Et LFE Atetg elgsta QUK

OJEE‘ OE pdflatexoﬂ)\ﬁ e

ST Q| TeX Live A|AEIS AL X7} O AlSLHX|
SOt EPS 7S PDFE H2tsto]

Lot Z= Ol XE 2t of QL

« https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.

html

3 Editd¥%

o] wl ol sgshs AFF2 BIEX Q] 7]-50] otz w3 7|9 ehadd Zlo] gt WA & 10
A, Zetg7] - EAlst7) - 2ol 7] - 2 7] - Zhobubat 7] (Edit[>Cut, EditP>Copy, Edit[>Paste,
Edit[>Find, Edit[>Replace) 5l sl ot= 2 7HA] ot E 9] 7|ulRld 2 Au e},

2.6 FILEDPRINT PREVIEW(Z3 0|2|E7])


https://www.ctan.org/fancyhdr
https://www.ctan.org/pkg/hyperref
https://www.ctan.org/pkg/url
https://www.desy.de/~bargheer/gitintro/git.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html

A2AL Bol WAL 517] glalAo)7| % sA % o] 54 ArtdS A steln
HAES e o7} ok BIEXOIA olo] slgel Ade FuE R SeKAL 87
gol Y Aolt}. o2 W AR gaEo] FE A} £42 RojaielH TS oA £ &
742 Wloz st

this is \textbf{bold text;}\\

this is also this is bold text;
{\bfseries bold text;}\\ ..
\begin{bfseries} this is also bold text;
this is bold text,too! this is bold text, too!
\end{bfseries}

3.1 EditD>Autotext(AHs&A)

].
o} 7| x}Eek4ole} st 71 oAt ‘PS’Ebal Eto] W5l ‘PostScript’ 2H 1 7\}50 2
Aol Qe 22 watt}, ofgEl7} o] LS sjFE}. BIEXolA ool sigs
A2 gk oha} 22 7o

\newcommand{\PS}{\textsc{PostScript}}

o] ZA| o] gt th-3of \PSet1 5= 2 \textsc{PostScript}etil YHsh= 2t
2t} thaga o] F sttt

4 Insert ¥
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)
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p—

4.1 Insert[>Breaks(

.+ o] Lhiro}x|%) b BUBAE ~ (Yu) 2 HATT

o
=]

-

i
[
ac)

o A 3 U7]=\1inebreakt \newlineS &t} E9] xlo| &= o}g) H7| FIIHH= \\ 2 \paret 2F 8| S
L =) | = AN L - o = A ‘|9 AjH |‘19,\IOL|'01X|’E 1%}”
E=N\2A Y Y72 g et ol =8 14 & 3Ho2 & 4 Aok MZFSIX| OF7| 20|l 0] 2O 2 RAC}

‘“14 \\E HZHME (BHE & +A)

>U

lcm]). I 74
A\ D \newline} 2| ZX|2t I (array,

~ " ing S)0iIA = oIxh & 9
« B2 EEE AZeEHE S5 FAU \par §8 & & t—ézbﬁugfﬁ;%né o e

. 292 Ho|A & Y+ \newpage == \clearpage H5o| tt.

\newline®} &a \linebreak= 3] 32 2717 -t

!
I am stretched!\linebreak I am stretched!
But I am not.\newline But I am not.
Another line.\\ Another line.

Ok,now you get it.

Ok, now you get it.

3HH \clearpage”} \newpage®t T2 & Ax| 92712 HEEo] Qe ZZE(TL
oy H)ES B F Z¢ ool o] & UeTh= Zolth SR Eo| tisiAl = 4.14%
ofA] g gict.
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4.2 Insert>Enumerated List(H g JI 2
Udd Et(list)oll= 22 1o A (bullet) & £0°]& <itemize>t HSE €0|+= <enu-
merate> 2730] Itk " \item HHol ¥ xS Bojslo] UdF Eho] 2ok mjg
7|55 o2 RO 2 g 4 Ut
bl i) * with an asterisk;
\item[*] with an asterisk; ’
\item[-] with a dash; - with a dash;
\item[.] with a dot. )
\end{itemize} - with a dot.
Zt FEo| ZAE = 5 WY (A BFS vt EOE 2 g AE
BE 45274 ¥ 7"]’—,1’-’57’(counter)1 2t S A olek= ZAolth. \labeliteni,

\labelitemii,\labelitemiii, \labelitemive=

itemize 73

ol 35kl \label -

enumi, \labelenumii, \labelenumiii, \labelenumiv+= enumerate2] 24 7}-2E

AEplolt},

G

e AEtelol] @ 57

L 42

3 g atet dupull ofEtolet, " 8koll \fnsymbolol2hs A=

A& usoll (1630 A]) g5l

I 1}, \arabic2 ‘YEF £=2}Fo]A \ roman<
E9 82 viii 2 E7]), \Roman-> &%} 2ot &2}, \alphe \Alph& 22

4Rt 2o

sl ofo] csl

\begin{itemize}
\renewcommand{\labelitemi}{*}
\renewcommand{\labelitemii}{-}
\item first level,item 1
\item first level,item 2
\begin{itemize}
\item second level,item 1
\item second level,item 2
\end{itemize}
\item first level,item 3
\end{itemize}

* first level, item 1

* first level, item 2
- second level, item 1
- second level, item 2

* first level, item 3

enumerate 2]

Eof| A Zup exbet thEAt SutslS 22 thgt 2o

ro

\begin{enumerate}
\renewcommand{\labelenumi}
{\Alph{enumi}}
\renewcommand{\labelenumii}
{\roman{enumii}}
\item first level,item 1
\item first level,item 2
\begin{enumerate}
\item second level,item 1
\item second level,item 2
\end{enumerate}
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X2 Z0j7l) HAE
=

ohs BHECH

E=
=

I'-II] o g

351 TEX T oblivoirs B2
2 M3t O 50
a, \ogana, \onum, \pnum
FeH 2ol o 7H Oh, @b, ©, (12
FCt.

A st

E
=
A

:oﬁ

A
T
\pga
2t2+
1
=Y

A
rob w

'BIEXoll 3kl W57k B A, A, DYWL HAE 24t A4 7H2E S 7HA A ol Aok
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\item first level,item 3
\end{enumerate}
A first level, item 1
B first level, item 2
i second level, item 1
ii second level, item 2

C first level, item 3

k2 W 0 2 enumerate T7] 2| & 22 W o] ot ' <enumerate> B2 A
AlstATE Aali17Fd 222 &

A AAFZ XA SHHA 2} 71-2-E] 9] & Alo] Z+ZF \Alph, \alph, \Roman, \roman, \arabic
Eg Folsteld 52

ofsto] G4 QA G2 ME AU A HE 4 9

o2 bt} 32 vejo] W ol9]o) Bl

E-Q‘E- ?‘TO-]_\L"E]'

\begin{enumerate}[{Example} I.]
\item First example.
\label{item:first}
\item Second example.
\item Last example.
Go to Item~\ref{item:first}.

Example I. First example.
Example II. Second example.

Example III. Last example. Go

\end{enumerate}

to Item I.

\end{enumerate}
5 o2 24 A4S v S e & Aot
\begin{enumerate}

\setcounter{enumi} {2} 3. Example 3.

\item Example 3.

\item Example 4. 4. Example 4.

\setcounter{enumi}{5}

\item Example 6. 6. Example 6.

H Ho}. <in-

I'll throw in a list of items:
\begin{inparaenum}

\item apples,

\item pears,and

\item oranges.
\end{inparaenum}

\begin{inparaenum}
[\itshape a) \upshapel
\item apples,\label{first}
\item pears,and
\item oranges.

The same list can be labelled with letters:

The first item is \ref{first}.

(% enumerate IH7 | X| 20 o Z&3
7|58 ME3sH= enumitem 7| X| = ULt

[A4F17]

memoir 222 = enumerate
IH7|X[e] 7lsE Bt Rleoz2 HE2
2o =Tt gt oblivoire

7h e, @, 7,00, 9,1, O, @), @

2h= &5 H2| XIAIXE F715t QUL
oblivoir 7} OtL|2}H koTpx Z=7t THZ|X| Q!
dhucs-enumeratelt dhucs-enumitem=
& nstet,

INSERT M|+


https://www.ctan.org/pkg/enumerate
https://www.ctan.org/pkg/paralist

S22 BHX 93 AAS

$ \$ or \textdollar
& \&
% \%

\_or \textunderscore
\{ or \textbraceleft
\} or \textbraceright
$<$ or \textless

$>$ or \textgreater
\textbackslash
\textbar
\textbullet
\textdaggerdbl
\textdagger
\textparagraph
\textsection
\textcopyright
\textasciicircum
\textasciitilde or \~{}
~ $\sim$

® \textregistered

™ \texttrademark

2 \textordfeminine

° \textordmasculine

>0 Mttt o — -V A

R

SEAE B Y

==
Jm
i
rr

\end{inparaenum}

I'll throw in a list of items: 1. apples, 2. pears, and 3. oranges. The same list can

be labelled with letters: a) apples, b) pears, and ¢) oranges. The first item is

a.
el clol 50l Aali1 247} 4 AR ABHRAHEH £A2 Sa
paralist'= o|8ol = ChFer 4. & 4 9o m 2 71X BAZ Yol g Wkch,

4.3 Insert[>Special Character(54&4})

wﬂ'HANEnhmngEw&qmaﬂ& £ A2 7198t o] 2AH5L ool
2ol 7Lt 43t BEo| A AL of B4 vhARE Abgstelof St E 25
Ea.
e
581t
=3

s
T

)

23}

24

rlr

th2 B o 2 ASCII ZE9F \char &S 2= Zlo] it} o
7}¥ZF\char36 \char38\char94 \charl26°]2}1l ¢]&35}o]

i

.
Mo
i

>
il
ilo

ne
o &
;O

AOFo EHW
Tﬁt?

rm

AU 7125 AlFohe H71A = Ao A& EH pifont 7| A=
\dingT} \dingfill, \dinglint, \dinglist B2 211 k. \ding HH2= EH
F o] Jul(Dingbat) 22 A=t \dingfillZ} \dingline& \fill®} \lineol
o33ttt \dinglist 2742 QIAtE F0i7 8l FEE & M2 AMESh= Y AES

o]
=

opEr
N

S
-

ot

™
Ny
l

AR

7t
tE

"oblivoir 54+ T{7| |2l xob-paralist
A enumerateOfl CHH A

Xz ot= 2gE 7
S FMH &L

4.3 INSERT[>SPECIAL CHARACTER(EL2X})
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https://www.ctan.org/pkg/pifont

RHEC)

\begin{dinglist}{43} 5 one
\item one
\item two = two
\item three
\end{dinglist} 1= three
2 271 9] dingautolist 72 017l Q1 Ato]| sligsh= ¥l T ERE| AJ&F5to] 2]
AES WE= B 752 A5t
\begln{dlngautollst}{172} @ one
\item one
\item two @ two
\item three
\end{dingautolist} ® three

713 A= U EotA o7 A tf AFE 4 ¢lck. 1 thAl “The Comprehensive BTEX
Symbol List' 2= &S 471518 3ttt CTAN://comprehensive. "

43.1 A238715(€)
S koas
7Fsaich
\usepackage[gen]{eurosym}
\usepackage[official]{eurosym}

eurosym 7| X 2 A2HE 4= =0, thZ3} 2 F 7HA] WA 0 2 ARS

rlo

A
T

- H5\euro BHP S Alastl 124

A3 €9} 2t} 0] 7|57} AEl s mapo] &

A { of whet 2t [gen] ML FH ZE T)AQloj 2§23} 7|52 A},
HHH = HA) B0 A2 €2t RS Qlafigttt. v]B3k o] 7} it \officialeuro
%“’—32 o J&o| HEA] o] ‘official euro’ Y-S A 4 Ut

23} 7] S+ marvosym 7| X o A = A F-5k=t, o] mj7] 2| = o|gto) $~E2 B

718 EE AHESHA Stk \EUR B 2 & €5 Qafigt 4= it}

4.4 Insertl>Formula(538H4))
BIEX S 53] 424 9] Z23to]l Z7o] ek, 43 7|55 glaEe] dre — olgfo] mE
(inline mode) —Z oW ¢ 252 1 AJZky} £-& vhephdch

I like math: $x”n + y”~n \neq
z”n\ \forall n \neq 2%
is my favourite theorem.

Ilike math: 2" 44" # 2" Vn # 2

is my favourite theorem.

VAN
QL
T
Ry
*<
3
Q
=
V4
1,9
VA
o
[
I~
8
S
S
\V4
rot
o,
rlo
0 4
o
ik
o
re
Sl
i)
e
H
Sl
o)
|o
Fu
Y
i
et
iu)
o)
>

(HF)7eX Live 2 A X|UCH &2i2of| A]
texdoc symbols = texdoc
comprehensive %'%4 2 Li2i=2at

(S50 olstot oSl S LIEHHE 7|5 W, ¥ 2
\textwon, \textyenQZ 1S % QIC},

(%21 amsmath IH7|X| 2 2= 5HH
\eqref FEE £ = UL ChS ool A

“Eq.~\ref{eq:fermat}’2t1 st EES
\eqref O = HIH Eq. (1)2 20|

LIEFETY,

INSERT M|+


https://www.catn.org/tex-archive/info/symbols/comprehensive
https://www.ctan.org/pkg/eurosym
https://www.ctan.org/pkg/marvosym

Fermat's Last Theorem
defined as:
\begin{equation}

X*n + y*n \neq

z”n\ \forall n \neq 2
\label{eq: fermat}
\end{equation}

Can you prove
Eq.~\ref{eq:fermat}?

is
Fermat’s Last Theorem is defined

as:
"yt #£2"Vn#2 (1)

Can you prove Eq. 1?

4.5 SymPy AF&H

m2 e Qojot AL EAEL 44 Qo] HE 24 S ALEAT SymPyeh wto] 4
2

7} e O

=

3 = x X
2 SymPy oflAlo]th, 92 4] (£ — 2) T RS WG L - LE 4 22—
(o3}

3
82% ol oH%Fon BEX 155

EIEX 42 22 4 3l mtojdo] 458

In [2]: init session()

types: python)

>>> from sympy import

>>> f, g, h = symbols(
>>> init printing()

In [3]: expr = (x/2 -

In [4]: latex(expr)

Out[5]: "\\frac{x"{3}}
y~ {2} - \\frac{8 y"{3}

In [1]: from sympy import *

IPython console for SymPy 1.9 (Python 3.10.6-64-bit) (ground

These commands were executed:

>>> from  future  import division

>>> X, y, z, t = symbols('x y z t')
>>> k, m, n = symbols('

Documentation can be found at https://www.sympy.org

Out[4]: "\\left(\\frac{x}{2} - \\frac{2 y}{3}\\right)~{3}'

In [5]: latex(expr.expand())

*

k mn', integer=True)
'f g h', cls=Function)

2%y/3)**3

{8} - \\frac{x™{2} y}{2} + \\frac{2 x}{3}
27}

ojA| o] A2 RE dojA= 42 ot E 2 BAMS o9 7|tk & \\& \Z =

75k st ek,
ghof nho] 4l Qlojo] S
BESAWEE AT 2500

S python BIEX 7] 2]+ LaTeX Expression project

4.5 SYMPY AF2H
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https://www.sympy.org
https://www.ctan.org/pkg/python
https://mech.fsv.cvut.cz/~stransky/en/software/latexexpr/

4.6 Insert[>Footnote(Z}3)

Z o3t 22 \footnote[n]{footnote text}et= W o} 4 xSl [n]= 2+
F HSE vttt \footnote P2 Tojet npy®, 4 H, 7|e} EHE S FHof] Fojof
Sig=

Mo Al 712 e Yoo HAES Zb3 7| S 2 ARG \footnote 7 EHE

\renewcommand{\thefootnote}%

dreee] mad) This footnote™ ™ says it all.
This footnote\footnote

{I mean this one.} readme'y 1 ean this one.

says it all.

ol Wl ALY 25 WiB g Rouleaht 7| SRAR Uehd 4 Uk,
\renewcommand{\thefootnote}

{\Roman{footnote}}

This\footnote{The first.} This' is the first footnote, and this" is the second.
is the first footnote, The end.”

and this\footnote{The second.} ;

is the second. Hﬁz fzz(tmd
\renewcommand{\thefootnote} At last! ’
{\fnsymbol{footnote}} ’

The end.\footnote[8]{At last!}

\fnsymbol{footnote}=til 3t H 2}
747}k th o} F Jle] 7| S EA 7L mE T, « +
SAgk Zhol oA M2 ohE 2 22 HEs g ool Y 23 HEs

W7 23 The 3} o] sl

This\footnote{the first.}
\newcounter{\myfootnote}

\setcounter{\myfootnote} This' and that® are footnotes: please read note!
{\value{footnote}} again.

and that\footnote{the second.} ;

are footnotes: please read note ztheﬁrst

\footnotemark the second.

[\value{\myfootnote}] again.

59]: minipage U0l = B hs B E9| 25 7B & 2h=tl|, mpfootnote©|tt.
\thempfootnote® 1 7S Q2h3F 4= U}

4.6.1 Footnotes and Endnotes(Z32} n]F)

endnotes 7] A= \endnotez}t= M2 Y-S #| L3t} o] WS \footnote At

gof| thAl 2™ H|o] 7] sltof] ZkFE o= th4l \theendnotes H o] Fo|+= 9o
Zota A ESHCH! Zolut Ao npz|ghof] M-S ot Q125  ujjof -85}t

INSERT M|+


https://www.ctan.org/pkg/endnotes

\footnote o2 U F o] 9
a137) YA E e e 5

lo
Il
N
:?L_’,
A
u)

\let\footnote=\endnote

2] 3 ofefet 22 Al 20| WS EA vhxstel Hof Pt} 2

\newpage

\begingroup

\parindent Opt

\parskip 2ex

\def\enotesize{\normalsize}
\renewcommand\notesname{O|F} %% HA} 7}
\theendnotes

\endgroup

Ak the 3} o] LpEpdT

e

fo]zte olzolt}.

4.7 Insert>Indices(Ex})

8 =3, & 23}, 1% 23 52 AASHE 2L XA UL kgt doltt the
2 onl

=
B2 249 A MA \section E= \chapter Ho| L} 7] Hoj Hojd

\tableofcontents
\listoffigures
\listoftables

W7t ob o 9= 2 A Aol olejdt 75 o] gtk Y= Z2AA o] SQIE] KEX

2
N
N
9
4
2
2
&
o
ojo
[
N
i
[
&

(2 gndnotes S AIXFE If 2= EfO|S
O3 2= \notesnameO| 11 7|£Z}0|
“Notes” 2 E|0f ULt 07| M ot=0{=2
Hoi5t7] 2/8f 0| ({2 2 E renewcommand
SHRALE.
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F 3: <tabbing> $7ol| M AHEE= H

L &
\= & AF A& At
\> O § A5 X2 o]53tt.
\+ 8 AF RS R EZ 07 it
\- AR AR E Y Ao 2 G
\\ 3Yo] &
\pushtabs REE ¥ AF & A4t
\poptabs  AZIH & AF A& E=j2Th
one.\hfill two\\ one two
\vfill
~ \hfill three \hfill
- ~\\ three
\vfill
four \hfill five
L four five
Lk 0 2 BEXOIAE 5 ool Fulg o= o8 Yol 1 et Lg%ur
E oo Ful g shuke] Ful o 2 7hEsict ey EA9] Ft o =l E A
335 o] o] Zule A 2 Wojof Shrhd, “FatA x| G B ~ RE 2 A}%ﬂa}.
Zo] 5 A Hsto] FHlg Fdod b \hspace §FS &0} »
This is a \hspace{2cm L. .
. pace{2cm} This is a 2-cm-wide hole.
2-cm-wide~~~~hole.
4.9 Insert[>Tabs(§})
<tabbing> B7 2 TAB 7|15 £ < wjo] $a7} fAEt ZutE Al geict. HrES o
(column) 1% 2 v} x| 54 Bl AHEFHTH H 32 o] B0l 72 2ol P QokstiL
ATH.
thg Ao WY AFgRe] o Aol
\begin{tabbing}
s @ 92E 43
~ \hspace{lcm} \= ~ \hspace{l.7cm} \=
~ \hspace{2.2cm} \= \kill % O| SHE HA|G}A AES
Zero \> One \> Two \> Three \\
Zero \> One \> \> Three \+ \\ % &I ZI¥ Q=& 0|=
Zero \> Two \> Three \- \\ % St 74 2|Z 0|=
Zero \> One \> Two \\
\pushtabs % & |z A&

new tab 1{\dots} \= new tab 2 \\
new \> tab \\
\poptabs % AZ3ME B (3
Zero \> One \> Two \> Three
\end{tabbing}

2o

=7 =

g

ng [o o

otrnpE W

Z| ZtAH0fl CHSHo] \vspaceE &
= == UL} CH2t \vspace=
SEE 3ol (H 3L ZsHA

vertical modeO{| A{) A{OF BtC},

=1
=



Zero One Two Three

Zero  One Three
Zero Two Three
Zero  One Two

new tab 1... new tab 2
new tab
Zero  One Two Three

<tabular>2} <table> &7 = Lo} XA},

4.10 Insertl>Cross Reference(22}&x)

Bl AEo] 2hil g gal 2hl 91| 2 WA RSt fl8lA \label, \ref, \pageref Ho]
AHEEITE 2L prefix:suffix P41 22 o] Sl Zlo] EFEHo|th, 7| prefixe o ! 4]14 0|I|%'$ 101 \egref

S =9 o= Zot. H(chapter) HE Ol cha, $4] M &of eq, 217 oll&= fig, A (section)

of| = sec, &0 tab.

A, #, 39 5°] o A& #Ho|A & FRoHHH \labeld \ref & th& E7]ek Zo]
ArgEr.

\paragraph{Example.}

WEIEUEIFEE GO Example. This paragraph ap-

This paragraph appears in

Section-\ref{par:example} on pears in Section 4.10 on page 19.

page~\pageref{par:example}.

22 prefix 5 A4l op2o E= Z o2 F = Hrt. enumerate 2| AE0] A8
olg Bat.

\begin{enumerate}
\item{first step: skip to
\ref{item:end}
< \label{item:start}} 1. first step: skip to 3
\item{another step
< (unreferenced)}
\item{end: go back to 3. end: go back to 1
\ref{item:start}
— \label{item:end}}

\end{enumerate}

2. another step (unreferenced)

4.11 Insertl>Margin Notes(o¥2)

Y& zrebsteh \marginpar{text}g}i AW Hr}, o] 7|5 & TR A Ao AL Z
27] o2l Hold. B}l El

4.10 INSERT[>CROSS REFERENCE (A=) 19



4.12 InsertD>Text Frame(Zd|Y)

(]

ZHJoz P HAEE £ dRE FEHAA UEU 7] 98l 22o]=t Ho]A]
AFolof A Umof A A] ¢k Hojz| o] 1A H fIx|of FlAE T3PS F2H textpos
o712 & o] g5t Hek » 1 Oﬂxﬂ £ 3" A5(FE A)oll B3ITh

_CL rlr

L
L

BF sl otz absposHH9|X|E—jf— BT
£95| beamer0i| M textpos7t 227 |=
Ho] 2] /o] £ 9] BAES 3 SAE ma - 2,
BAIZI= Zlo] ot e <minipage> ... Ol HAE = njyd|o] x| & HrA
(Y olA) &4 2 & 4 Aok A= 2 4 Aoltt. <boxedmini-
B3 Q= HIAE = minipage 2 TH& page> 74 o] 72 o] 2] wfj7| %]
o7l Zlo]t}t. minipage BfAE 1 A of| 2|50} A B =},

oloi|A] o] %] 7} Lirof 2] %] o
<minipage>At&K2 ot Z2 FAYE Z7I5HAE
\begin{minipage}[position]{width}
iéﬁd{minipage}
<boxedminipage>°llA| Ze| Y} HIAE Apo]o] IHA L th-Z o= 3Tt

\setlength{\fboxsep}{5mm}

4.13 Insertl>Image(°|n]#])

z0): OJE)X] (image)2t 18 (figure)}& THE Aol AHIE AL 4148 S K},
PDF, JPG, PNG, TIFF 2° 5} 2 % o]n| x| & AH9l&t 4= 9It}. PosTscripTU EPS TFY %2 ryxt= TIFFE 07| M 9128t D
5 5 UL T TeX Live A|AE2 TIFF Z2HO|
= Z3tote 3“4”‘ otut AFEE Z o= AFEd Ao 2 3lo] o] ot & A 2|5kAY OIDIXEZ Hgﬂoﬁm oFCh T sl st
PDFE Hglel= WS okm 9] 8 Ao}, ¥ EFE 0|&3t0] PDFL} PNG £ convert
e Si2=0{0f BICH,
725t 1 7] 4] graphicxoll A #|3-3H= \includegraphics H 2.2 o|n| x| & xg}gt

4+ 9k,

[SF2onjo| x| 2= 125 H Dt
This is a lovely picture

This is a lovely picture
\includegraphics[width=3cm]{piper.jpg}

of a guy playing the pipes.

of a guy playing the pipes.

height, width, angleZ-> T2t0|E] & £ 4= 1ok, widtho] A7 ©9l= 9l2] H 7]
M dolE Fol ke H I gAEL Y Zolof] JUigfoz Fojsf:= Hr)

width=\textwidth % THO| F= H|
width=\linewidth s A 2Ho & YH|
width=0.5\1inewidth % linewidthQ| ZHt

& 7k e R BE JE = v 2|52 adjustbox 37| A5 thgofl B9 &3t
@Wﬂ EEE} H A

20 IS


https://www.ctan.org/pkg/textpos
https://www.ctan.org/pkg/graphicx
https://www.ctan.org/pkg/adjustbox

\usepackage[export]{adjustbox} e
(4%728] 1 XH= “multi-column textOfl

; o = = . . HMEDCH N S0 Q0| ALHE FXH L O]
adjustbox T 7] 20|l [export] &A1& Fofsto] =5 \includegraphics BHoll so yxo Tz‘jjrlol =etct mslet ofn|e

. . = [e]3 MRS » el
left, right, center, outer, inner®} Z+-2 42 3714 0 & Hojst 4 gle}. upx|at = 7o) “twoside() & iEQO“ He Bt Shor

. StCh & inner2te AR —|o(sp|ne)
ALt g AEo|A A= Zlo|t}, B (RE2% Hlo|x|2| 2% 2 —EJHIOIIIOI
9_5—9 outer2h= 2 MU 2

Jtal7|= Zolct.

This is a lovely picture This is a lovely picture

\includegraphics%
[width=3cm, right]{piper.jpg}

of a guy playing the

< pipes. of a guy playing the pipes.

H|ERY o]u] 2|7} PDF #¥ o]n]z]of| H|sto] FA o] 22| ob=
8|3 a9 ol SL AA 2| RH Ards] AR = AT Q)

[H2H adjustbox= W2 Thet 71 52 Al g5t mi7| A o]t} 7| A& 28 off [export]
FAE FEAAE B e, F9 22 A4S \includegraphics B33 g7 27
a5 [Export] = it}

vertical alignoil B3t ¢l 2 st S0 T2}

\includegraphics[height=12pt, raise=-1ex]{piper.jpg}

a3 +7 9421 & g £ 5ol tiskel 2ok & w7} ik,
Fo|g 2 raise keyE Y] \includegraphics 71 E o} U350l AAsfof stoh= 7
olck.

4.14 InsertD>Figure(&x)

2% (figure) 3742 0]0] %] (image) S A+ 3H= AT SA5kA] gkt AMA figure o] W&
o] oju]x|2 =W x3} glrt. figures Bo]x| o] nAHE E4 925 ZH= o] ofa}
mrhys Zo|n BE 74o] B3 1% MEo| thsto] mabgzd 4 k. o2 AL o=
Z o] <figure> 274 olt}. ofelo]l £ Z& figureol T3t ol S Ho|Zlct,

\begin{figure}[htbp]
% [htbp] E2E7t =Y A& AY
% here, top,bottom,separate page.

\centering =8-)
\texttt{=8-)) 79 1: o QHUIA] RS Leh
\caption{O| QtLHA AAE LtEtLH= An}el g

PN LT
\label{fig:mysmiley}
\end{figure}

Sdslof & AL, figure= HFEA] ZEZ JElsh vl 2 1 9)x]of] Uehdths B3 o]
Q= AR olt), Qle =2 A|A 9} vl wsto] 2 T2 Ao figureSo] LY H 9| S 24
Feths A, figureZt Eol& X BIpX o] TSt 7Hg 2% o] /x| 2 “friy =

4.14 INSERTD>FIGURE(&T) 21



\begin{figure}[htbp]
\centering
\includegraphics% ,

‘Gruplot 30 graph

Sinfex + yYIBex + yy) ——

[width=0.7\textwidth,angle=-90]%
{gnuplot.pdf}
\caption{Gnuplot I2{j=}

\label{fig:gnuplot}

\end{fiqure} 1% 2: Gnuplot 1=

(float)” Zio|th. 12| B2 figureS A Al o} “Chg 1370} “g]o] 13" 2p -2 A
AFoNAE QE AL I ~\ref{fig: label}\ g B a}'?} L2 4 02 Fxalof &
ol2|&t 442 wl 2ol figure®} table2 L= A (floats)2t 1 EACE Z2E 7|

4] EATE X0l T AT here H7]1 A& AR 4= =T ©] 7] A= H(*A
o| X (HERE)o|2he= Seo|t}”) 9% 214 F4-& Alggtct.
a8E& UeHs] 289 subcaption T 7] 2|7} A|3-5H= subfigure B & AHE

=
77 37 e ATE PS5 Uk

|o

o)
fru

=

ol

ol

\begin{figure}[h]

% first subfigure

\begin{subfigure}{0.5\textwidth} % half figure for 1lst subfigure
\includegraphics[width=0.9\1inewidth]{piper.jpg}
\caption{Caption of 1st subfigure.}
\label{fig:subfigl}

\end{subfigure}

% second subfigure

\begin{subfigure}{0.5\textwidth}
\includegraphics[width=0.9\1linewidth,angle=-90]%
{gnuplot.pdf}
\caption{Caption of 2nd subfigure.}
\label{fig:subfig2}

\end{subfigure}

% whole figure

\caption{% 7§Q| subfigure& 72l figure}

\label{fig:image2}

\end{figure}

4.14.1 B9 uyc=tEId

Aol A &3] B Boke o el 2382 wrapfig H7] A & o] &350 LA 4= i},

(%29 e moir/oblivoir Ol = here
I§7|X|E AHSSHK| @=Lt
[g"xrw'}')]subcaptionﬂoﬂE subfigure,
subfloat, subfig S subfigure 7|52
H|Sote 17X 7+ 2 ULt
memoir/oblivoir0l A= Xt @E 2L
subcaptionS & == 11 O|H M7 |X|E £
S ACH

S5 rapfig22ts 17| X = et
wrapfigS 7148t Z10|CL wrapstuff™=
L&Y oSt

2roF T3S margin0fl S& 20 40|
ULCHH <marginfigure>et= 22 E

X Zst= W7 [X|7F F UACE memoir”t O]
A S TN X[ sk L1, sidenotes,
sidenotesplus, keyfloat S0| Z2 0|E2]
sE 2 ®MIBCh 7| X| 2ME &ustat

22


https://www.ctan.org/pkg/here
https://www.ctan.org/pkg/subcaption
https://www.ctan.org/pkg/wrapfig

(a) Caption of 1st subfigure.

Gruplot 3D graph

SinGeex + yy)ioex +

vy ——

(b) Caption of 2nd subfigure.

1% 3: = 789 subfigure S 7H figure

If you meet this guy,give him some
< money.
\begin{wrapfigure}[4]{1}[5pt]l{2cm}
{\Huge

~\texttt{=8-)}

}
\end{wrapfigure}
The reason may not be clear to you,
but I can assure that your money
will end up in good hands.
I say again,if you meet this guy,
give him some money: he knows how to
use it properly. OK?

If you meet this guy, give him some money.

=8-)

The reason may not be clear
to you, but I can assure that
your money will end up in
good hands. I say again, if
you meet this guy, give him some money:

he knows how to use it properly. OK?

AAE QA= 1HE 7] Yoto] BE SojoF T 39| 4, 2do] Y | (htbpe}
e X 2| A A}), Bojuj7] Zo], 7] o}, 32 BF 2 wrapfigo| IXIXIHRE v, i, 07
Rt 242} 2Eio] Chsod 215, SE= obz,
Efé*—.olﬁf 2/0|O|Ct htbpots &2 &
4.15 Insert[>Shapes(=3%) SHLZIS RIESHOF ett.
PGF/TikZ= Z20e|Ystso] 23S AT 4 = vl 28 oi7] Aot} th&
of 7hekst of| Aot}
\begin{tikzpicture}
\draw[red, thick] (-2,-1) -- (2,1);
\draw[green,thick] (-2,1) -- (2,-1);
\draw[blue,ultra thick] (0,0) circle
(1cm) node{\huge \LaTeX};
\end{tikzpicture}
oj& Tt A olelo] A& AH e A o 4 Ut TikZ.netS ol Eet.
THFWYSIWYG 138 18] 7] 2 730] H @ 5thH Inkscape(https://inkscape.
org) AT} o] T2 UL WK S A AR = 447} HlAE] 4G WK A
o= g4l
Inkscape & A 85t1 G5t E2 =2 17 tF5 v FollA] Extensions/Text/For-

mula (pdflate)...°]t} Extensions/Render/Mathematics/LaTeX (pdflatex)...&

EELE

4.15 INSERT[>SHAPES(=¥)

23


https://github.com/pgf-tikz/pgf
https://tikz.net
https://inkscape.org
https://inkscape.org

LaTeX input:l\LaTe)({} math: Se ~ {i\pi}-1 =09 ‘

Additional packages (comma—separated}:[ ‘

[ ] Live preview

Close Apply

Eile Edit View Layer Object Path Text Filters Extensions Help
Do &8 3aE| - 0OY B @aa oa®l v
o @ iE o5 B 7| x[e2sos [J v[essassfy v
[ ‘-ZIS? [ B B ) |0\ LI I B I |2|50I [ R R ) |533I [ B T ) |Twsol [ B B ) |1‘.:‘J Q
; B
A ‘
£ 1 T*I]:Xmat T ] ==
T "
Q b
Oz _
0
® - shapes
O -
g >
0
© ] normal text LN
as
: -
e - !
AI T 3
> -[<| | m | \)]H ’
XEEEEEENT = EEE NV —m—
i [>]
Etll-;,ke; Unset O - L) [L] Group oflob|e¢ g;i ;g z:

a3 5: KIEX o] YA ZiAl o] |

2B+ 2 JiA 2 23tE = B estohy 2 sol|A] B Hhet
2= ot &4 E 192 PDF, PNG 5 KIgXo] A|¢st= Toio 2 Y

r-‘i
n{tl
i)
1o
I
o
o
Z,
oXx
ol
N
do
:oé
e
Y
i
[
&

« GLE (Grahics Layout Engine)+ S 8
o A3 g dojojr}, [...] GLE+= ILEHEQ} Y &9 HAE 9 £4] 283 KX
of| o]&3s}aL Itk https://glx.sourceforge.io/

24


https://glx.sourceforge.io/

. Asymptote= 725 WlE] O2jg 7% Qlojolct. §lAUZAS =S 12)7] 93
ArA A FHE 7 g AlFetet. e A5 BIEX o 2 Y EST
https://asymptote.sourceforge.net/

rE rSL
]tl _li

« LaTeXDraw+ BIEX 2 9Ig 18 HYY 7|0}
https://latexdraw.sourceforge.net/
« Graphviz= 23 BIAE Qloj2 J el g 7] &ot BIpXol L3 tholo] 13
BHECH
https://graphviz.org.
ol& u7] 2] & o] oA BIpX & A3t 28 ER) w8 1S ¥ 4 ek ofdol®
@t} “LaTeX vector graphics” = & A sl e},
a8 4 =580 22 o8] 7k 7} Yot TrX Showcase B 0] 2] & WMo B H
E0)g AF5Hs ol o2 BAT 4 9l Aol

https://www.tug.org/texshowcase/.

4.16 Insert>Page(@|°]A])

B PDF H|0| 2| overfull 2] ¥ & Wz] &2 B2 AAshe 22 pdfpages 7| xS
2t g}, oh5a 22 A o = ARgsit,

\includepdf[fitpaper, frame]{pandoc template.pdf}

o] P2 2.48of|A HQl Pandoc 2 & TH50]A| = PDF FA1E AUttt o3 o] %]
= 9o F=E At A3t Y4 E PDFE \includepdf$t Zx}olct,
pdfpagest olol|l = o8] 71| 7]5-& 2b31 Qloy mj7]x] EA S glojH &= Zlo]

4.17 Insert>Rule(FA)

gJele] Zojot £ 2 7R AL \rule Yoz et

This is a page-wide
rule:\\
\rule{\linewidth}{1pt}
but this one is shorter
and thicker:\\
\rule{2cm}{2mm}

This is a page-wide rule:

but this one is shorter and thicker:

wsh oz Zog HAS 2= \dotfill o] Ut §Ast AL AZAS

=)
ok
ol
i
iu)

Total price \dotfill \euro~10 Total price ................ €10

o
=

L EEZE

Ax|ot=

4.16 INSERT[>PAGE(H|O|X|)

25

F 3 overfull 2 ‘of|2f 7} obL|2t <A
20| ELt,

arojLt,


https://asymptote.sourceforge.net/
https://latexdraw.sourceforge.net/
https://graphviz.org
https://www.tug.org/texshowcase/
https://www.ctan.org/pkg/pdfpage

This is the title:
now write the rest

Guido Gonzato

January 2018

Abstract
This is the abstract.
Contents
Section 1
Subsection . . . . . . . . 1
The End 1
Section

This is bold text, this is emphasized text, this is normal text. If you're bored,
go to The End.

Subsection

This is verbatim text.

The End

My dad used to say:
Damn, Pandoc has not been invented yet!

but not it has.



4.18

hyperref 1]7] 2= URL % 98 Fx0] g3=
<o dlE

Insert>Hyperlink(slo] & 3)

S o] 2AE theat 2ol HAstsL,

7h5 o0} PDE7} Bake A 7

PF5 A s

\usepackage[colorlinks,
urlcolor=blue,
filecolor=magenta,
linkcolor=darkred,
hyperfootnotes=false]{hyperref}

g o=

\urlstyle{same}

The \hypertarget{ctan}{CTAN} main site
is \url{https://www.ctan.org},a.k.a
\href{https://www.ctan.org}{CTAN://}.

Listen to \href{run:midifile.mid}
{this MIDI file}.

Click \hyperlink{ctan}{here} to go
back to the top.

The CTAN main site is https://www.ctan.org, a.k.a CTAN://.

Listen to this MIDI file.
Click here to go back to the top.

T B3-S \hyperref 41¢l o] Foj

JEHoR \url BYL LS B A4t BET}

\urlstyle{same}

7]

4.19

FAHES HEHYE %5 7 49| dof] Eo]AY comment 37| X7} A|-8-5F+= \comment,

%% PDF g tjoj u}e} z| Yol 5]7(] oko 4 olr},
_]

hyperref T7] 2] FA]E- gloj®E A},
Insert>Comment(F4])

5172 2r} 35

\endcomment HH I} comment 73S &

rlo

o
[%
kel
2k
o

=)

This text % boring example
\begin{comment}

what a boring example
\end{comment}

is just an example.

This text is just an example.

2 FO{A URL F2E
o HAES 7

MLE-H, [l s

. G2k 2| o] offFIof M=
.

™
o
nio
it (U
%
ot
Ot
=%}
o

[g‘?y’]memoir/obhvonroﬂ)\‘l IHHo =2
<comment> A2 HSTICH
\commentson, \commentsoff HHOZ

0|2 EO|HLt &2& = ACh

4.18 INSERT>HYPERLINK(3}0|m{2!3)
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https://www.ctan.org/pkg/hyperref
https://www.ctan.org
https://www.ctan.org
https://www.ctan.org/pkg/comment

[S47"36] [ 2 x|elskk| ot
_ . B _ pdfcomment= X3TEXS X SHA| 2

PDF &3 Z0| Y LEA S 45 £0]7] a4 pdfcomment HZ| A& AH = 4504 2123t soul 221 TH7|X|

- * soulposE 0| I§7|X| 7} &&5t7| h20f|

Sick. o) SHNOIAE Th83} Z2o] MIBISLT, ofe) PDF 418 ol o mgjry. % wubosS O S Mol
U2 == UL pdfmarginpar2t= ZHHS
[icon=note,color={1 1 0}]{pdfcomment} 71X 7t ALY pdflatexh EICE 0]
H|=%t 7|52 4= todonotes = A THE 4~
AULE.

This text is nothing special
\pdfmargincomment{yup,definitely.},
but it contains a couple of
\pdfmarkupcomment{nice}% tains a couple of nice comments.
{simple,more than nice} comments.

This text is nothing special, but it con-

PDF ¢ %42] 79 PDF Holol uet (At g 397} &S opea,

5 Format Y%

dutA oz FA9] 7|2 mHf &£/d& HAA5t7] /s = \documentclass H 9| A=
Hojghth, AT 4 A= sz 7|18 & 271(10, 11, 12pt), 2] (adpaper, a5paper,
b5paper, letterpaper, legalpaper, executivepaper), 8% (portrait, landscape) 22 Z°|

At

\documentclass[a5paper, landscape, 12pt]{article}

EE 37]of thd}te] 5.2.3 0] o] AHA|5] =52

5.1 Format[>Line Spacing(3} 7+3)

setspace W 7| A= <singlespace>, <onehalfspace>, <doublespace> ¥73S |55ttt 1
2|3 \spacing{amount} W& (F7) 22 Jojo] & 7+ k& AT 4 ik ¥ (5% 57 memoir/oblivoirOil = setspace S
L2 ZE5HK| Yot (MSXHE tHEXE

ote) 2 gt dE e AsY + Utk

[21#}H \singlespacing, \doublespacing, \onehalfspacing-2 B# |1, <single-  ofzich \singlespacing®l CfSoH=

space>, <doublespace>, <onehalfspace>+= &7goltt. Ao Y1+ A 5t= <spacing> \Singlespacing 0| A1 <spacing>
CH! <Spacing>S MM E|= Alo|Ct,

< ...ing2 & BUA|Rt g7o|tt. o] PEje AR = 1 FHo] FEEojoF a7t

Upepde.

NEREH S PREIRE {2 5] These two lines

These two lines \\

are crazily spaced! .
are crazily spaced!

\end{spacing}
\begin{spacing}{1}
Much better,these lines\\ Much better, these lines
are spaced normally. are spaced normally.
\end{spacing}
= sta0f 2 A ChH 2 B2
= A3 o olo =
BA Ao 2x Y 2+4S 22 AAstHH \linespread{factor} §H2 Z2|Y ﬁ;fju‘{?'gﬁ_ﬁ;’%"ﬂﬁ;fﬂﬁiﬁ'
]2k 1 0]t}. 38 o] Zto] A AW 3 AJo|o] 7HAE o]}, #S MBSt oblivoird =22

= eI NMO 7|2 160%00 7HIH AS
= o83l QlLCt.

of A Ht}. factore] 7|25k
Y7 ek 1.6 o] gho] |

Z e

28 FORMAT il =


https://www.ctan.org/pkg/pdfcomment


yup, definitely.



simple, more than nice

https://www.ctan.org/pkg/setspace

5.2 Format[>Character(ZA 2%)

F49l 27 B £4L E 0] IS, EE 275 uhE B

x2E4< = 8=
QA E = ZE o] AR 37|+ documentclassol] F-o1H 712 37](10, 11 £+ 12pt)°fl uf2t
gt 1 63 et
22t 474 89 27 oA
\textnormal textnormal main document font
\textrm rmfamily roman
\textit itshape italics
\emph n/a emphasis
\textmd mdseries medium weight (default)
\textbf bfseries boldface
\textup upshape upright (default)
\textsl slshape slanted
\textsf sffamily sans serif
\textsc scshape SMALL CAPS
\texttt ttfamily typewriter
\underline underline  underline
\textsuperscript n/a this is superscript
\mathrm n/a X"+ y" # z2"Vn # 2
\mathbf n/a x" + y" # 2"Vn # 2
\mathsf n/a X"+ y" #£ 2"Vn #£ 2
\mathtt n/a X" 4+ y" £ z2"Vn #£ 2
\mathit n/a X'+ Yy £ 2"Vn#£ 2
\mathnormal n/a x4yt # 2"n F# 2
\mathcal n/a XN 4N #* ZNYN %2 (59 512 2 oM 0] =] & ZHx2
O Eoieh Zlvtof BOHE BE2 QiCh
H4: ZA S =m S| M= T2 22 AL
KM=z EHSt= Ag M@oh= Tt 0
CLH-HH HOlE0|| e Q= HO R QA 2
7181 A A (italics) 2} =4 (emphasized) 2] xto]of| th3l| 3 3lof gtct. th2 ol &S 7|§(|>_Ij gzs _"llotuj(F PEHE) "HS
B \empht Rio] B}2 4 A2 o] 98-S B 4 Utk o]gk 2ol \emphi A oot do| et e e
efol E 225} & A Jole WHol ohviet £ F2E bl g Roloh ¥ M LA glou H s 1

Of{IHTL ZE EHES 24 AR
AR QICtT & 4 2Uck

\textit{For example,this portion

< of text is typeset in For example, this portion of text is

— italics,and \emph{these typeset in italics, and these words
— words} are emphasised in are emphasised in upright.
< upright}.

3, o} AHE 44 BEO|AEF AL§3HE Zlo] Uviolct BE el Ao ALg3te]

p=! L
=] * (o .
ot ohaah 22 Egle & 4 ok [ wlojafet E2lg £

\textsubscript HHS Edt0] Yt
- HAE0f| Of2iMXtE &g 2+ QAT
this is \textsuperscript® OFEHZEA]
$ {\mbox{\footnotesize% this is subscript
{subscript}}}$

shepahe Al e 44 BEA eisto] ~ot 2 Yatet ol WAE AR 4 9tk 1
2Lt mhchem 37142 o] 8314 | 2hestet, At vl ol H AR Soj7he] ~ 15

5.2 FORMAT[>CHARACTER(ZX 22 29


https://www.ctan.org/pkg/mhchem

ZE 37] oAl

tlny sample text
scriptsize sample text
footnotesize sample text
small sample text
normalsize sample text
large sample text
Large sample text
LARGE sample text
huge sample text
Huge sample text
E5 EE 37]

Default font size 10pt 11pt  12pt

tiny 5 6 6
scriptsize 7 8 8
footnotesize 8 9 10
small 9 10 10.95
normalsize 10 1095 12
large 12 12 144
Large 144 144  17.28
LARGE 17.2  17.28 20.74
huge 20.7 20.74 24.88
Huge 24.8 24.88 24.88

gl

theol 9 212 A A4TITE S AL \ce B QAR Yt

\ce{H20 + C02 -> H2CO3}\\
\ce{CaC03 -> Ca™2+ + H,0 + CO;, — H,CO;3

= BN CaCO; — Ca® +CO5%"
\ce{C03"2- + H2C03 -> 2 ) )

< Hco3/\_}\\ CO3 + H2C03 —> 2HCO3
\ce{CaC03 + H2C03 -> Ca"2+ + CaCO; + H,CO3 — Ca? +2HCO;"~

— 2 HCO3"-}

H|s=oF 248 LA chemformula 37 A = Qlch.

S7)% 4] g Zlo] QukAolt, o) 4

o) A2 ol BAb| 2 28 29 A de) Aoz
A 27) A = gkt :LE:MEE%L m WEE WhEA] Tojof Shehel ulem 1745

=
= UE o] & 712 AL S A BFomx 171X Zol|A luatexko= X
o} ulemRF BH S MSSHCE XgTEXO|Lt

: pdflatexO[2tH ulemS B = 2EDHC,
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\uline{important}
\uuline{urgent} )
tant urgent boat

\uwave{boat} important urgent boat wrong

\sout{wrong} oY ed

\xout{removed}

ulem E’H;,]Z]% ’%}?j_ %io] E‘.Eﬁ]"l‘ \emph EF]E:] o ZHX—]_‘]OI_O:] O] EH ‘_]_ ‘?.:]% %7]5&
B}, o] 2 wate| W tha ) o] §41S Fojstet. @ HF 2 ylem It R AL 752 X 281 sou

17| X|= QLI EL SOFA|OF 2Xt2 &

\usepackage[normalem] {ulem} A8 At TS Bl sciatin

lualatexOllAl= 0| & AFESHA| &*t‘:%
5.2.3 Format[>Character Size(Z 24})
BIEX o] B Alo] 22 Z R3] gt extsizes T 7| A7} =&0] € Zolth, BE A S
AS Sto], 8-12X QN E | 14,17, 20XV E M-S 2712 Hojg 4 QA st
oAt 22 17pt article= /35t Shohal s A}, 12 oh5ak 2o A &betH
=

\documentclass[17pt]{extarticle}

2 2722 A= g2 3L typelem T7| A& o] &= Zolt), thg1} 22 Mo

L Fs)}. BF Cltypelem= 222 type1 CM2Z 2
Adsh= 70J0] 220 M 20|17t ALk
QIfiZQl QEEIY EES AF8%H= TX
\fontsize{72pt}{72pt}\selectfont AZIO A= O] TF|X| O] % Of| M| 7} K| A| Bt
No Smoking PO oot ZRE HE UL

(o] oAlA| 9] Atz o] EAoll EAsH o U 27| w2l A} oAl S ettt +=
QA 217k EE 2719 w0l 22kl (34) ) Lololc.
k2 AP o2 ohg it o) sk £ 9ok (5544 ok )| 47K adjustbox Ol

\resizebox2} OFXH7IX| 2 gHA XK 2
2toistE HEO| HOl=[of UL 222 o2t

=

Ze g o= o yYe

\resizebox{!}{1lcm}{1l-cm tall} 1 _Cm tall \adjustbox{height=1cm}{1-cm
tall}OlCt.

1 ©HEE & A FAI5HE lettrine lettrine 7] X2 \lettrine Y& < o]-&
U stk of2] 7k ARgAEE 7hs gt o] Bkoll A Kol A& thga} Zo] 7| Bzke
2 2 Zlo|H,

\lettrine{D}{ropped} capitals at .
< the DROPPED capitals at the start
start of a paragraph can be of a paragraph can be ob-
obtained using the lettrine

tained using the lettrine package,
— package,

5.2.4 Format[>Character Font(ZE

BEX 2 Y 5240 ZE A|AHRS 2F20 9l 7|2 232 Computer Modern©] T},
METAFONT A EA| ARl 53 Z o gt mjnjtt 238 ZES A5 o= Attt o]F 7

5.2 FORMAT[>CHARACTER(ZX 22 31
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oz of FRoM e AT 2 S Bt FE 2HE ST 4 AT Y
$-2]+= &2, Times, Helvetica, Sans Serif & T2 Z72] ZEo| 2% A Qlct.
thad 3], BIEX A7 PostscripT Type 13 @ ZEFQ] OTF ZES &85 4= ek

avant, anangar, bookman, chancery, chanter, courier, helvet, helvetic, ncntrsbk,

newcent, palatcm, palatino, pifont, times, utopia, zapfchans-°] Type 1 ZEE &

23 o] 2835 4~ Q1= wj7] A 50|t} \usepackage{times} S Ze|YLEoj Zojgom

2 T MR
oG E=A] Zels Ha}. o] A= libertine T7] A& ©]-&-5F3iTt.

Chek, 4]S o2 wjoll= Computer Modern EE S #|-835}= Zlo] 2 Aojgte Ao
Sol5}zt. T2 ZE S AF851H 48H4]o] Y7t o] A E AnE A 2o}

FUIZER EFER, LEE] EES A Yot xelatex2 A2 2ot & 4= =
o] AH A Zotzltt. LaTeX Font Catalogue YAFO| EE HhEoto] o EET} Jl=%]
i) =it

AollA AFE 7| A 52 24 Ao EEE HASH= Zoltt. ofte] BlAEofgh
£ EEE A -&3te i o2 oAloll A Eol= 2| font family & A siE . &3]
2:0] = font family S E 70l 2 ks FAch. B font shape 7t L Eol| A& A =] 7] g
& AtHe AMA S dobRat. 10

This is Computer Modern Roman,
{\fontfamily{phv}\selectfont
this is Helvetica!}

[FAH GFolA AFeH HZ 99 clA| & XqTEX o2 ZHutdshs H g 2ofA& A A
2=t I Al ok |9k o] stofof st} Latin Modern©]2H CMolA] & 2 ZE}Q] :EL

L 2X Xg¥TEX 9] 7] ZE 0|4l TeX Gyre Heros= Helvetica®ll th-5-5H= TeX Gyre 2%
(2Ees))oltt. EE JHE 95l fontspecs ZE3oF 5h=t] pdflatexZ ©] 7] 2=

L =1
A QehA| =

\fontspec%
{lmromanl0-regular.otf}%

This is Latin Modern

— Roman,

{\fontspec%
{texgyreheros-regular.otf}%
this is Heros!}

This is Latin Modern Roman, this
is Heros!

5.2.5 Format[>Character Colour(Z*} A4)

-

color = ]3]

xcolor B 7] 2|2} Ted g o & FAtof| Mg Q)
white, red, green, blue, cyan, magenta, yellow 7} % 2] =] o] Q]

o] ol 4 ek

o

23H3 A A

2= 9it}, 7|2 A 0 & black,

SFelze my|xe faye HotYsts
QUEION I A| ZLEICE O] EHEf2 =2
pdflatexO| ZIH AIEIQN Aol MLt
Folojsict, HAEE xelatexS 01850
Aot st=g| o| mf o|2 mi7|X|= 2|a| 7t
AL FOfM ArZsHiOF BT}, T 1=
libertine I§7| X|:= pdflatext xelatexOll A{
DF FESHA SEfetct.

(57461 0| 2etof| A LSH= font family, font
shape S2 pdflatex AIZEI0| M M0|= EE
e A A”o] Bojolch, QLIBE ZES
st ATl A= 0] BH2tol L0
MEE|X| =0t H 7= OFEIEX|CH

[

AR * 47

5971 0) 2| Ho|=l MASAIS xeolor 7t
CHSHA MlS st A} H latexcolors,
ninecolors S M4 H2|E NS dt=

Ij7|X1S0| ULH.
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https://tug.org/FontCatalogue
https://www.ctan.org/pkg/color
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FE ue 9y

=
cmr Computer Modern Roman
cmss Computer Modern Sans Serif
cmtt Computer Modern Typewriter
pag Avantgarde
pbk Bookman
phv Helvetica
pnc New Century Schoolbook
ppl Palatino
ptm Times
pcr Courier

H 7: A 2ol= ZE sjU ] (pdflatex)

\textcolor{red}{This is red.}\\

\color{blue}

This text is blue!\\ This is red.

So is this. Let's change.\\ This text is blue!
\definecolor{mygreen} . . ,
{rgb}{0.1,1,0.1} So is this. Let’s change.
\color{mygreen}

This is my shade of green!\\
\color{black}
\colorbox{cyan}{A cyan box}\\ ‘Agreen box in a blue frame‘
\fcolorbox{blue}{green}

{A green box in a blue frame}

A cyan box

Lol7h, \pagecolorzh= o] l=H|, ofH B3-S 7H4 27 she BH A A2t

2t AAk-S 93] ARto 2 S8 ekrhH contour T7] 21 & 0] §3ko] g2 (2] ZHA)
ZAH2 TS0 2L \contour BH L FAE 168 ( st sleutE) A3 Ao
SIS ThSojWlict, SFsg0z M e et GEE]

\contourlength{0.5pt}
\Large
\textcolor{blue}{\contour{red}

{Blue text,thin red outline}} Bluemthinredouﬂine
\contourlength{2pt} mmwmm
\textcolor{white}

— {\contour[32]{blue}

{White text,thick blue outline}}

5.3 Format[>Paragraph(£% 2%)

4 B ‘=0
BHS\U 8 22 Zut gaEo] AR 2 A I e KXol H45hs AUS 3715t Sxqce sicy. oo w)
2}, Jé-u»: 74% ot

5.3 FORMAT[>PARAGRAPH (2 22 33
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Ll | A

abstract Qorr

array S8kl o) i

center 7hedl 8E

description ARd B AE

displaymath HY 29 (displayed) 4]

document A HAE e

enumerate Ho R g AE

equation Hey 2y (dlsplayed) £8H] (A SR

figure o= 18

flushleft AX A4

flushright =z Ay

itemize HSHFGAE

letter HA 4

list 7|1A g AE 27

math = (In-line) 44

minipage ]quHO]Z]

picture HAE Shabm ajd o 59 =Y

quotation o2l £ A& (A & 59927 AUF)

quote EF AEET(AH E 50127] 8le)

tabbing B AamZ ol 42

table oY= &

tabular Yt d 2 HPEE HAE

thebibliography &% 5% Z]AE

theorem A, HA 5

titlepage A2 A4

verbatim AHES IiE Hol7]

verse Aot &8

8 EF KX &7
HIAE O] gdHo| EASH &4, o) FE FAoly ZE Y 52 Folot7] fls
217 (environment)< ©]-&3tt}. o] A2 vix] nfe AR HAE AR E HEsto

2HE B4 £4& At AY HES S5t AT fAGIT S22 R HAE

\begin{environment}
..text goes here...
\end{environment}

o
Mo

o & S0 KA},

& 7hetl JE5H7| 2 5FH <center> 735 &35}

\begin{center}
this text is centered
\end{center}

this text is centered

Bl
HN
riot

Q=

A4S E 89

2.opstgich. ofef 1 AHg

ct.

HE ® 7k Hol3l
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5.3.1 Paragraph[>Horizontal Alignment(3¥)

72RO R FH FEEEFOE HHT X% HHoly L2 HE &= vt
JE L2 <flushleft>, <flushright>, <center> &7 ¢toll AEZS W=t} Py FAQd
\raggedright, \raggedleft, \centering©] o] &7} zt7 SALSHA| HHst= 2

e wrEAu A 2-S Boto] Al&bely] A7HA = &} UEbUA] ok}

5.3.2 Paragraph[>Vertical Alignment(Z% Alc]e] &)

EEE PRI BEXS B0l 9 T2AN AHEAS0] FFSHE B 97E 5 Ak ¥
Zo]L} Zajo] of2] 7 ok SHFe] Bl &, Sife] FH o2 g} whebal ¥l £E ofg
7N L s A 2 Aol 7t B ’oj ] = Zlo] oy gh= Zolth. \smallskip, \medskip,
\bigskipo]gh= B3 S 2ot Alo|of] HA|Z 02 & ofdojo} Rrku} Rk Alo|o] A=
4= 4 Atk

7.8 8ol 7 Ack \vskip @ he 8719} o] Mol om Hek. Y

These paragraphs will be sepa-
rated by 1.3 cm:

These paragraphs will be

separated by 1.3 cm:\\

\vskip 1.3cm

there is a 1.3 cm gap above me.

there is a 1.3 cm gap above me.

\vskipZ 2 =X & Atojoj x| gt
o] gl= AFefol|Al) ellZIth 1.5cm 2] 34y
\nullS (Qle B2 tiAl) ‘BRI 2 4F

[¢]
)
N
N
)
rulo

“é%HOF ao

\null
\vskip 1.3 cm
This text comes after 1.3 cm...
This text comes after 1.3 cm...

o2 \vfill ¥o] o} & B+
A B2 & 1 Hlo| 2| 2] vidol] @A Hrt. thg

702 Hor o ALgIT =
ole aslat.

=
e

This appears at the top of
the page{\ldots}

\vfill

{\ldots}and this at the

— bottom.

This appears at the top of the page...

...and this at the bottom.

25004 £, 2ok Ze 2 Aol 2H HGEE Zolct, 3 M Holut BeF H2 7
st 7 3 HJX—%RE 51857 ghth o 2o BREg Mr e Adste dhoiel the

[H3+50]

\vskip TeX BEO0|1 \vspace=
BTEX EHOILH 5[ =5 \vspaceS A& F0|
Ol K| ot ofl2{ S w4 QUCH \vskip
=3 O:”AIO-“);IQI»?I‘O' Z1o]| 7'-911"0'” &!17

= AHA =
\vspace—"OI Zos 2 SHMAN
OIxt2 FTBiCt,

[m?“]IéTEXOI \vspace BHO| HES

=0 A \vspace*x YA o2 M HHO|
F0{Z1 /%] o|™ (% o|=)0f| 7| &= 2 ¢to]
SO X ZHAS He|7| R 220N

A-H:l:i sto OIE A LS FIHE AS 2 i}

5.3 FORMAT[>PARAGRAPH(

I'-IIZI
m
02
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\newenvironment{margins}[2]

{
\begin{list}{} {

\setlength{\leftmargin}{#1}
\setlength{\rightmargin}{#2}

} \item }
{\end{list}}

o 2ol HelFt §4S ket Lol AHETITE.

As you can see,this paragraph
has normal margins.
\begin{margins}{0.5cm}{1lcm}
But please note that this

paragraph has custom margins.

\end{margins}

As you can see, this paragraph has
normal margins.
But please note that this
paragraph has custom

margins.

5.3.4 Paragraph[>Indentation(E°27])

L
.

Z Eoj27)o] 27]5 A5t \parindentgl= Zo] H4
E927]E lemZ Sk 2ot

\setlength{\parindent}{lcm}

\indentﬁl} \noindent H&< 1 t}So Q=
92 \parskip Zo] mjetu|g| 2 Rtk Alo]o] 717

209 5

\setlength{\parskip}{3pt}

5.3.5 Paragraph[>Border and Shade(Z&| 93} 39)

=1
L

S} framed T7] A1 & 20t = \parbox ¥

Foholy Thojof T8 2]
8519 =t o] uj= calc 7| %7} L 5}, >
47 framed & o] &5}= o] 2 Ho|z},

F=

o
[

\setlength{\FrameRule}{2pt}
\setlength{\FrameSep}{5pt}
\begin{framed}

this is a framed paragraph!

\end{framed}

\definecolor{shadecolor}{rgb}

{6.9,0.8,1}
\begin{shaded}

this is a shaded paragraph,

do you like it?
\end{shaded}

this is a framed paragraph!

this is a shaded paragraph, do you

like it?

He

EF Ao oMo e MES BHS
Holsto] A1 =0, memoirOl
<adjustwidth>2H= &40 0| 7|53t H9|
FAtet A S MBS TiC) memOIrO\ A
changepage T 7| X| (T 0| 5
chngpage) 2| 22t SYSiCE.

(5553 g S =E =
=AM K 2 Ato]of

kJ

Ae [[HD;I-_);-|\|_§
7"Ol ofL|2h= o ==
2] S parsk|p
20| ELt.

= [ 10 rot
M
[ d
rr

%5 emoir/oblivoirOll A= framed

7| X2 2 J7|5S KA FE St UL,
SHH I Q%I Bl AE 180 QU0 A=

2rot IH7|X| 2 adjustbox, efbox 2/0f|
tcolorbox S BtEA| AAg 8 =2 $tCt. Of
HHEL I | XK= HA[SH A S T2|=
=Hof AoIM BRot He tiRE2 7158
M| Z etk

36

FORMAT 0|57


https://www.ctan.org/pkg/framed
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18] a1 boxedminipage 37|27} QlHl, &2 o529 #4 2 & 4 WA k. =&
JES FAH oh T 22 WS Wel= A2 AMA <boxedminipage> 732 2= AT
sttt

\framebox{

\begin{minipage}[c]{\linewidth}
text to be framed
\end{minipage}

}

\width sj3 =2
oltt. 22 Agctul

o7l HAE

this is a

\framebox[\width]{framed} this is a framed word

word

A9l4kS 45k =9 =& vtE 4= QU

this is another . .

\framebox[2\width] [r]{framed} this is another
word word

T A FA4 QA= = k] g0l ¢ uljo] HH vhalZ& 2| At o] BI|oA=

©2&(r) Joltt.
)

HoU olA] A= AAsta Ak, oA sk,

5.3.6 Paragraph[>Colour(2%

2ol mailg)

olo
o=

\colorbox{yellow}{
\begin{minipage}
{0.8\linewidth}

I am a minipage,my I am a minipage, my colour is yel-

— colour low!
is yellow!
\end{minipage}
}
oAl AJoll A Bl %0] minipageet 1 M2 8 HH]e] 80% T A 8= =5 A5}

Aol tiste] B ZRAIRE A2 5.2.58 2 Fratstzt.

5.3.7 Format[>Columns(thdh)

\twocolumn®} \onecolumn HEP -2 M2 Ho|A =
\documentclass? A oZo|E| 2 A QT 4 9}‘4. ojAo g FEA
7] X7} A &5k <multicols> 73 0] Sltt. o] & o] 835lo] o] Ao] W82 o] E’P_E 2

shaA Yohwl the M A S Aol s

%_ggnHam 0|52 multicols2t1
AA2 HOICH SHI2AH| Sxp7+
. multicol 2| ZH2 BIEA|
%IOIXE*I&W oo fEi“if
CHEIAEZ st 4 oICH= 0|},

5.3 FORMAT[>PARAGRAPH (2L 2¢)


https://www.ctan.org/pkg/boxedminipage
https://www.ctan.org/pkg/multicol

\columnseprule=1pt
\begin{multicols}{2}[\subsection{\entry{Format}{Columns}}]
The commands \cmd{twocolumn} ...

\end{multicols}

o Ato] o] A2 \columnsep Z o] M2 Aojgtth \columnseprule tiA2 & o
Atolol Zojz & Ao] £7]15 Uehdch * RS2 Bo M QA e AE L thok S M5 42 x| er02f 0] S opt 2
NZ817] ol s B 0] A WA RS 2ashe REoth s
6 Table W+
2|2 (2=7E) ol A AS Sg3ttt. o] et FA|E ol 7| s EAat
o]0 X (image)7} figure9t= Th2 A3t uF7IR| 2, <tabular> 3747} Z (table) = N 2
2o}, KEX 9 tableo] st 212 wthy = 714 (4.148 0l A ™) 2 A 3t o] x| S o7}
A %= Zolojop gtrt. AMAE F 4 A AR <tabular> 7S 71 Qtol] Z3FSict
<tabular><= 53 ZH O & ]=dljof of=t] o] & dsiZlct.
7] WX tabular 7HA1= o33 2ol A ogict,
\begin{tabular}{|l|c r|}
s %, 5Y,2= 42
s A2 3, MES
% MEE2 BE 0O[/E0[|A st}
\hline 1 2 3
1&26&3\\ % &9 & a c
AL s w8 Hd one | two three
a& &c\\ % FHH ZH
one & two & three \\
\hline
\end{tabular}
A7|M £, FE, Aol 5 AT AZ & 4 At} tabular?] 3 3§-2 &l 2J 5t
£o)8 AYUESE ol oA},
booktabs 7| x| & 0]-85tH A 2F0] gl o MHAE BFE Z2HE tabulars 18
9,1‘;]'.*57 (%557 memoir/oblivoir= booktabs 2]
7|sE XAl X5t ULt
\begin{tabular}{lcr}
\toprule
1&2&3\\ 1 2 3
\midrule
a& &c\\ a ¢
one & two & three \\ one two three
\bottomrule
\end{tabular}
2ol Eol&= A oA = tabular 7HA| S X g sl WS At
38 TABLE 0=


https://www.ctan.org/pkg/booktabs

% 48 H; AZR/SY/REE ¥E; 1¥
\begin{tabular}{lc|rp{4cm}|}
\hline % =g
\textbf{Left} & \textbf{Centre} & \textbf{Right} &
\textbf{4 cm}\\ \hline

row 1,col 1 & row 1,col 2 & row 1,col 3 & row 1,col 4\\
\cline{1-2} % 1-2 ZEO| MM

row 2,col 1 & row 2,col 2 & row 2,col 3 & row 2,col 4\\
\cline{1-2}

\multicolumn{2}{|c|}{spanning two columns} & row 3,col 3 &
row 3,col 4\\

\cline{1-3}

row 4,col 1 & row 4,col 2 & row 4,col 3 & ~ \hfill right\\
s ~0f| o3 2|2t

row 5,col 1 & row 5,col 2 & row 5,col 3 & left \hfill ~\\
row 5,col 1 & row 5,col 2 & row 5,col 3 &

~ \hfill centre \hfill ~\\

\hline

\end{tabular}

I

Left Centre Right 4cm

row1l,coll rowl,col2 | rowl,col3 rowl,col4

row2,coll row2,col2 | row2,col3 row 2, col4

spanning two columns row 3,col3 row 3, col 4

row 4,coll row4,col2 | row 4, col 3 right

row5,coll row5,col2 | row5,col3 left

row 5,coll row5,col2 | row 5, col 3 centre

tabularray

o] 242 a7} Z71et}t, = E (tabular) = 2 SS9 KX AFEALS 1 &5 2 EA4A
ohget @ ek A7of S5k £, Hi7| A S0 hZ o 2H iR o] o 717t Ad 755t
Al = Aot YR g2 a2 A ool 23] Folo] o] Ql=A] &7 o2 A7t = ATt
tabularray+= EEE J2)= 0% Zstal F84 Q1 wj7] 2 o]t} o] RhA & E7}5to]
T 3ol tfste] Agshe EA0A A 7I5Hs A Q] B2 7]5& key=value TS °]§
sto] &gt 4 Qlok. Wit v oA Yot 2 2S5 YUS Aol
QJol| A A1E BE tabularray 2 <iblr>2 2] ol & Bo|Zth,

\begin{tblr}{
colspec={Q[l]Q[clQ[r]Q[4cm, 1]},
hline{1l,Z}={.8pt},hline{2}={.6pt},
vline{3}={.4pt},
vline{3}={4}{dashed}
}
\SetRow{font=\bfseries, fg=olive5} Left & Center & Right & 4cm \\
row 1,col 1 & row 1,col 2 & row 1,col 3 & row 1,col 4\\ \cline{l1l-2}
row 2,col 1 & row 2,col 2 & row 2,col 3 & row 2,col 4\\
\cline[dashed]{1-2}\rline[dashed]{4}

TABLE 0%

39



\SetCell[c=2]{bg=gray!30,c} spanning two columns & row 3,col 3 & row
— 3,col 4\\ \cline[dashed]{1-2}\cline{3}
row 4,col 1 & row 4,col 2 & row 4,col 3 & \SetCell{r} right\\
row 5,col 1 & row 5,col 2 & row 5,col 3 & left \\
row 5,col 1 & row 5,col 2 & row 5,col 3 & \SetCell{c} centre\\

\end{tblr}
Left Center Right 4cm
row 1,col1l rowl,col2 | row1,col3 rowl,col4
row 2,coll  row2,col2 | row2,col3 row 2, col4
' spanning two columns | row 3, col 4
rowd4,col1 rowd,col2 | row 4, col 3 right
row5,coll rowb5,col2 | row5,col3 left
row5,coll  row5,col2 | row 5, col 3 centre

tabular 7} W& Z o] A

£ A22 $7U Fol 420 HHAY 5 Yk

St m|o] 2] Qtol] E07}A] ¢= w7} lT}. longtable TH71 A&
0]-8-5}of of2] o] z|of] Z 2] = tabular g 2H/dsh= 7l o] gt 71A] ®hRo|tt. $HH rotating
7] A= <sideways>2r= 732 A|-5-5h=t o] & ©]-85tH tabular HA| (= cell 5FL)

tabularx I 7] X|= E 2] UH|& DA Z 0 Z AT 4= 93 X AY A A|AE o] &35}
AP Z A Foll thsto] FiAQl Aol =2 WAL & 4= UA st
= ol Alo|t}.
\begin{sideways}
\begin{tabularx}{7.5cm}{|1|X| _qg
= X[} b g
\hline 2 £
\textbf{normal} & 2 —
— \textbf{tilted} &
\textbf{wider}\\
\hline
normal & \rotatebox{30}% 160
{I'm tilted!} & g X
I'm wider\\ = 3
\hline = i
\end{tabularx} = .
\end{sideways} = §
= =
o
= &
R85t oj7| A &0l St

4bol &= [ongtable, supertabular, xtab 22
=

I Qtof| A M-S 23 colortbl T7| X & o] &
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https://www.ctan.org/pkg/longtable
https://www.ctan.org/pkg/rotating
https://www.ctan.org/pkg/tabularx
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Colour by row:\\\vskip 2mm

\begin{tabular}{lcr} Colour by row:
\rowcolor{cyan}
one & two & three\\
\rowcolor{green} one two three
one & two & three\\ _
\rowcolor{yellow}
one & two & three\\ one two three
\end{tabular}

Colour by column:\\\vskip 2mm

\begin{tabular}
{>{\columncolor{cyan}}1 Colour by column:
>{\color{red}
\columncolor{green}}c
>{\columncolor{yellow}}r}
one & two & three\\ one three
one & two & three\\ one three
one & two & three\\

\end{tabular}

one three

6.1 Table[>Line Spacing(&2] 3§ 7+4)

r°l'

eloj o] 9 7422 BlAE ] olof Ero| A AL $ Fo] AZre}r] Hof 274
AL 8 FHhH 7HE (length) 7} 0pto] I Y3 0] (height) & 2H= Ho|z] b= A
\rule 12 E2o] Qith. 3 0]Fo) AL Falw \\ofl g4 A= ol S A A3k

ohg o2 ® .

\begin{tabular}{1l11}

one & two & three\\

0.3 centimeters & one two three

< \textbf{after} & 0.3 centimeters after this line
this line\\[0.3cm]

one & two & three\\ one two three

one & two & three\\ one two three

\rule{Opt}{1l.2cm}1.2

— centimeters &
\textbf{before} & this
— line\\

\end{tabular}

1.2 centimeters before this line

6.2 Table[>Aligning Numbers($x] J3)

I

tabular & 1 v} S8G F92A 23] 2o A5 AXE 71202 LsHor T
oIt

Vg Ae e @ 2Y ANRE ol gok Zolth. SRR Teehn gl ol
A 2 Wik, Ay Relxt &7t 250 2 whHT

6.1 TABLEI>LINE SPACING(HE 2| & 7HA)
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\begin{tabular}{r@{.}1}
3&14159\\
1861803\ \
1841421\\
100800000
\end{tabular}

3.14159
1.61803
1.41421
100.00000

$HH | dcolumn T 7] A
b= Al 7He] RIS ZH=

(B2 = E} OIEH

mm

‘1)}1]:“

14 rlo mx
B e

o op

o
N
o
|
—
o
rg
i
ol
1o
_>‘~_‘ Flﬂ é; l‘)‘ o

0

il

4

A

o

2% A AR

1 ol &7 154 ¢¢@ 2202 el 247

2712 2 4 QA =), o] XA

oltt, Al A AAHE A (dot)
A
1 AR e,

“$\mbox CH4l amsmath®| \textS &

\begin{tabular}{D{.}{,}{4.2}%
D{.}{.}{53D{.}{.}{-1}}

\toprule

\mbox{One} & \mbox{Two} &

\mbox{Three}\\

10.33 & 10.33 & 10.33\\

1000 & 1000 & 1000\\

5.1 & 5.1 & 5.1\\

3.14 & 3.14159 & 3.14159\\

\bottomrule

\end{tabular}

One
10,33
1000
5,1
3,14

Two
10.33
1000
5.1
3.14159

Three
10.33
1000
5.1
3.14159

6.3 diagbox(e] tjZ+d)

diagbox T 7] x]= \diagbox §#¥& |33t}

\begin{tabular}{|l|1|1]|}
\toprule
\diagbox{Lesson}{Date}

- &
Monday & Tuesday\\
\midrule

Date
Lesson

Monday | Tuesday

Stratigraphy & room A
— & room A\\
Chemistry & room B &
— Lab $\alpha$\\
Physics & room C & Lab

Stratigraphy
Chemistry
Physics

room A
Lab o
Lab é

room A
room B

room C

—  $\deltas$\\
\bottomrule
\end{tabular}

(55759 of| & 0f| slashbox IH7 | X| 2 EHAd st
2ALY T2 E 2|50 diagbox I 7| X|=
slashbox 2| & 74X FFof| CHet XS 5t
ULt 3222 L%l slashboxE Aot
oot gich
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https://www.ctan.org/pkg/diagbox

6.4 BIEX E A7)

£2]5] Dol Al tabular ] W& st 2= 22 AZ-S dolot. ohdls| A o=
THE tabular W8-S BIEX =2 A5+ Ao EVL Q).

Sin’

« https://www.tablesgenerator.com/
o https://www.latex-tables.com/
« https://tableconvert.com/latex-generator

o https://products.aspose.app/tex/latex-table-generator

6.5 KIEX H°o|EE t°o]¥] 7}x 27

S-2] RojA doje it 2 i YRE sHst= ol & gaé}t}. HIOlEi qu El & o
222 )9 A AL TES th ASCI Tﬂr%‘% ol = ‘zlxlﬂi
Sttt 719 tiEo] AZFHEAE

7
2}
ST} S0 YA ExfE 4 9|

O
H715k= 2] 7}—°Ptﬂ, a8 22k ‘;’E ﬂ—t— 2] %E} o SFelgy 1At Ho|2E0] ot TAB
o o 1L Z2XfLE 7|Ef 2XHE M T EX|2E (Csvel=s
tlolef oo} W82 BIEX & P4 o2 vighsto] Hshe A2 AAR Lolth. oFl o209 ojnjgp= za)) *lE(,):(jEfﬂ
25 uij_%ag UNIx & sh 232 EQld glo]g mtS 9]ojo] AP Zoj gbxo] T =M, 10I1R= 2 28 o| Ao
A

#!/bin/sh
# dat2tex.sh: converts tabular data to a tabular environment
if [ $# != 1 ]; then

echo "Usage: $0 <datafile>"

exit 1

fi

# is this a csv file?

grep ";" $1 > /dev/null
if [ $?2 = 0 ]; then
AWK="awk -F;"
else
AWK=awk
fi

# ok awk,make my day
$AWK '{if (1 == FNR) { \
printf "\\begin{tabular}{"; \
for (1 = 1; i <= NF; i++) {printf "1"}; \
printf "}\n"
)
for (i =1; i < NF; i++) \
{printf $i" & "} printf $NF"\\\\ \n"} \
END {printf "\\end{tabular}\n"}' $1

# end of dat2tex
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7 Tools Hl%

7.1 Tools[>Mail Merges(H ¥ ##])

o] 98513 A7 HoFslA| sl 7152 textmerg H7] x| o] FAE o] Y} EA
g0 EAol| A o] 231} 4, YL upioj R 7heket A2 AYzte| Rl 1 o]9|o]
g2 st

B ol A Pekr| L BB sl Al /o) HE (feld)S A 2|8 Zlolch. Zkzk \Name,
\Surname, \Titleo]2}1l 3}#}. o]oj sfd5l= ZH2 e)& utAd?l data.dat ZFE] 7}4]
er},

\documentclass{article}
\usepackage{textmerg}
\begin{document}

% let's declare the variable fields:
% \Void is for empty lines
\Fields{\Name\Surname\Title-\Void}
\Merge{data.dat}{%

Dear \Title{} \Surname,\\

may I call you \Name?\\

Yours,\\
\hspace{3cm}Guido\clearpage}
\end{document}

u Ha =9l \Voide AA| 3 A2 ol gt dA|E ¢5to] =ik 1 o
apolA 7] &7} 2o Jlet o] A2 dlolg oA Hlo] gl 4 A& YErdct 7t
HREe] 22 ¥l F& it
data.dat ot e] W&-2 o]d 4]0 & &|of 9]}

Guido
Gonzato
Dr.

Francesco
Mulargia
Prof.

Marie
Curie
Mme

7.2 Tools[>Labels(2}2 ZA)

Hd W27} L ohd 2 vhE 7| = o 7hdsich 3x8 AE]F 2hE 84 Q]of] 53 ek 20
NE grEtha S B}, ARSE w 7] 2], I &SHAITE [abelsghe Zlojth, Th2 of| Alofl A
1070 1 k2 1070+ g 5
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https://www.ctan.org/pkg/textmerg
https://www.ctan.org/pkg/labels

\documentclass[adpaper,12pt]{article}

\usepackage{labels}
\LabelCols=3 % n. of columns of labels
\LabelRows=8 % n. of rows of labels

\LeftBorder=8mm % borders of each label

\RightBorder=8mm

\TopBorder=5mm

\BottomBorder=5mm

\LabelGridtrue % show the grid

\numberoflabels=10 % number of labels of each type to print

% the text of the label is specified by

% the \addresslabel[]{} macro:

\begin{document}
\addresslabel[\large] % optional arguments
{\textbf{Guido Gonzato},Ph.D.\\
\textsl{GNU/Linux Sysadmin}}
% now on to the boxed labels
\boxedaddresslabel[\fboxsep=4mm\fboxrule=1mm]
{\textbf{Guido Gonzato},Ph.D.\\
\textsl{GNU/Linux Sysadmin}}

\end{document}

ehgo] N2 The F48 TGS LA steln o)io] 242 HojE 2R 7
(]

\documentclass[adpaper,12pt]{article}
\usepackage{labels}
\LabelCols=3
\LabelRows=8
\LeftBorder=3mm
\RightBorder=3mm
\TopBorder=8mm
\BottomBorder=8mm
\LabelGridtrue
\begin{document}
% use either this environment:
\begin{labels}

1$~{st}$ name

1$~{st}$ address

1$~{st}$ city,state,zipcode

2$7{nd}$ name
2$"~{nd}$ address
2$~{nd}$ city,state,zipcode

3$7{rd}$ name
3$”{rd}$ address
3$7~{rd}$ city,state,zipcode
\end{labels}
% or an external file containing exactly the same text:
% \labelfile{addresses.dat}
\end{document}

7.2 TOOLS[>LABELS(2H& =t4)



textmerg®t labels & Z23sto] &-85l= AT A =sl|E 7] v,

7.3 Tools[>Default Language(t}=°])

BIEX 2] 7|2 doj= Fojoltt. 2|y thE doj = 2|3ttt of 7|4 ddof 2| olzt 3t
‘chapter’ Ut ‘index’2t 22 01 & Z=roofl 87| AAshe= A, S8k sholZulo] A #4,
a8 gy et e FAES VI HRERRE(BE2 \c cH Vet Zo] Y= A
JGdr= A5 9t

KIpX v 22 holl = language . dat 2= 2+ o] ($TEXMF/tex/generic/config/language.

~

dat) Z3tEo] QlEd of 7ol 7t /lof E-2o] 9lt}, o] updg W50} O ARER/}F Qs F o) malg Abg XLt HESH OF BTk,

oy oy o 0| 2A0] Cf| O|Ef I} 2 TeX Live 7t M St=

Stol = 722 7k Qlolg Mg 4 Stk 20192 1 Aleh 0 SX|%10fof i)
Qo] AH&AF7E ob 2t babel 7| A& o3 of| ek o] A&t ATAPHO| TH S HES 4 QUCH= 2N

H= =]
B 2 0N °“‘ﬂ¥9 g gonzf APEXF
SO0l 2101 HEL2 babel OfLt 210
\usepackage[italian,english]{babel} I§7|X| £ 0|85t A0t

I=5°  babel2 ¢ EAE 45t Aojof] AgtstA viit= 4971 et Thef 2217}
Qihe B2go 2 YettA] =t \charxx WAl o2 sl B},

EI R EL A IR YT E Z2HE 221 o E]7F UTF-8 & ol sliot =% sfjof
g g7t 9l 18]l 2018 o] Holl= inputenc®t fontenc T 7] X7} H 2 34,

\usepackage[utf8]{inputenc}
\usepackage[T1]{fontenc}

2018 °|F, BIEX ) 7] & &2} 91292 UTF-8°] H{ct.

HEL D

o] 2 A7t F71eIt. =0l E 2R A= BAE ASte WY EEL2 koTpX
7] Z] () & ©]-83t= ZAolt}. pdflatex, xelatex, lualatex Zt %10l thsto] 3t= 229
L& AFsta 2 FA = FH7I

\usepackage{kotex}

koTgX $lol = g2 EAIsh= 22 2417k flek. thFet dlZlof] oiste] ohafst W o]
7fek=lof Qlt. o] & E9 pdflatexo419] cjk-ko, xelatex°ll 412 polyglossia 5] %12 Ujl
E73] lualatex 3}l A babel 7| #| 2] AF& 7FeAd & &obA] 7kal Qltt,

7.4 Tools>Hyphenation(s}c]Zu|o] )

A 2 BIEX o] Tol Q] sto] uj|o] & 2 X 2] st Hol 2
Sz Zlo]l B d 4 ot 2] sho] &2 fJsiA] At
o U2 P 0 2 o] & 2]& thg1} Zo] s F= A= 7Hssitt

\hyphenation{ge-o-phy-sics ge-o-lo-gy earth}
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https://www.ctan.org/pkg/babel

o) o] 5ol & 774 Aol o AJoi] ©J5HR ‘earth’2h= Trol = o] Clo A sFo] = X254
247 i}, o] gfol] £ Thoi7} sto] = 2] |x] 947 5t2lwl L ol S \mbox Sl =Tt

Do not hyphen \mbox{internationalisation},please. I'm a masochistic
< man.

7.5 Tools>Spell Check(Z=} A}

ETEX AbAl & E Aol sl 2] 2ottt A2} HAFS I8 A £ ispell, aspell 22 2|7 =0
oJaljof et 2 Unix Al2|IOA ispell S Thgat ZHo] AFE-3F 4= Ql},

shell> ispell -t mydocument.tex

-t 29131 ispellol Al TX 2 BIX 52 FAIstekn 235H ok, wrep ol )
ohUjehe -d 912 2 % Qlo] ARS X sl Fofo

W
e
o

shell> ispell -d italiano -t mydocument.tex

8 Help "+

2RQ1Tf @ mEkol S 9hESh BIEX B T2 A+ B2 Wiio] k. e WhEsl Hotof
St 22 CTAN Ato]Eo|t}h. https://www.ctan.org/tex-archive/info/.
« Unix A2 R 38olA info latex HE= Hel™ BIEX HE 2 7Hdol tisto]
S| S e A S Al e
« https://www.ctan.org/tex-archive/info/LatexHelpBook/ EIEXol thst
o2 55 =&Z 2 A Windowsol it -8 = 2 = of gt

re,

« https://groups.google.com/group/comp.text.tex/topics #A&15S
FoHA & 4 Qi 2% £8S 9 4 Ak 7HAE Aol

o] #AZ WslAtH, tfFE 2] GNU/Linux B Z 3ol Al x| 4= Ql= g Tx/

ETEX Al AR TeX Liveoll 01 Qlek. Zytol] 282 #4E& Al&3th. Y2] Ubuntu

71419 /usr/share/doc/texlive-doc/ T2 E]g] olgjo| A EAE 23 4 Ut o
Liol7h, texdoc 2 B45] -85ttt ol & =01, fancyvrb 7] A5 I th=&

Wee Y.
shell> texdoc fancyvrb

9 mix|=%¢

o] 4= ® Guido Gonzato©l] 2J5}o] Zlu|d| ZE 2 A|&5HH GNU A5 &A] glo] AR
Hj2Z 3t} o] 7to] =7t = 2-0] & 7| & gt} of Aty FHIE gt Zxloj| Al HuUjETh
H oj-¢ 7] & Zio|tt,

7.5 TOOLS[>SPELL CHECK(EX} ZA})
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22 A BN WS

article 222 9] ’IE2 2. 180 B}, ol o B2 A& HF

L=

s},

\documentclass[twoside, 11pt]{book}
\begin{document}

\frontmatter

\begin{titlepage}

\title{The Book of Mine}
\end{titlepage}

\author{John B. Smith}
\maketitle

\tableofcontents

\mainmatter

\part{The Beginning}
\chapter{Introduction}
\section{Let's Start}

The book starts here.

\part{The End}

\backmatter

Thank you for reading this book.
\end{document}

1% A.1: Book template

\documentclass[twoside,12pt]{report}
% tables and figures at the end:
\usepackage{endfloat}
\begin{document}

\title{Final Report}
\author{John B. Smith}
\date{London,\today}

\maketitle

\begin{abstract}

This is the final report.
\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\part{Start}

\chapter{Begin}
\section{Introduction}

The report starts here.
\end{document}

1% A.2: Report template

48

\documentclass[12pt]{letter}
\begin{document}

\address{My address}
\signature{Guido}




\begin{letter}{John's address}
\opening{Dear John,}

Thank you for being my friend.
\closing{Hope to see you soon,}
\ps{P.S. Say hello to granny!}
\encl{My son's photographs!}
\end{letter}

\end{document}

17 A.3: Letter template

\documentclass[adpaper]{article}

\usepackage{typelcm}

\usepackage{times}

\usepackage{color}

\usepackage{rotating}

\pagestyle{empty}

\begin{document}

\begin{sidewaysfigure}
\fontsize{2.5cm}{2.5cm}\selectfont
\centerline{\textcolor{blue}{\textbf{Please:}}}
\vskip 1lcm
\fontsize{4cm}{3cm}\selectfont
\centerline{\textcolor{red}{D0O NOT}}
\centerline{\textcolor{red}{SMOKE}}
\centerline{\textcolor{red}{HERE!'}}

\vskip 1lcm
\fontsize{2cm}{2cm}\selectfont
\centerline{\textcolor{magenta}{If you do,}}
\centerline{\textcolor{magenta}{you'll be \emph{deboned!}}}
\end{sidewaysfigure}
\end{document}

13 A.4: How to write a notice

\documentclass{article}

\usepackage[absolute, showboxes]{textpos}
\usepackage{color}

\usepackage{framed}

\usepackage{graphicx}
\setlength{\TPHorizModule}{10mm} % standard unit of length
\setlength{\TPVertModule}{\TPHorizModule}
\setlength{\TPboxrulesize}{1lpt} % box line width
% start everything near the top-left corner
\textblockorigin{®mm}{Omm}

\thispagestyle{empty} % no page number

\begin{document}
\setlength{\parindent}{Opt}
\definecolor{shadecolor}{rgb}{0.9,1,1}
\begin{textblock}{5}(0,0)
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% this block is 5 modules wide; height is
% automatically determined
\begin{center}
\begin{minipage}[c]{0.8 \linewidth}
\begin{shaded}
This block is placed with its top left corner at the “origin'
on the page,which has been set to (Omm,0Omm). The internal
margin and the shading are provided by the \texttt{minipage}
and \texttt{shaded} environments.
\end{shaded}
\end{minipage}
\end{center}
\end{textblock}
\begin{textblock}{6}(10,1)
\includegraphics[width=6cm,angle=-90]{gnuplot.pdf}
This picture is at (10,1). Note that rotating it
by -90 makes it overflow the margin.
\end{textblock}
\begin{textblock}{5}[0.5,0.5]1(2.5,8)
This block is at position (2.5,8),but because the optional
argument [0.5,0.5] has been given,it is the centre of the block
which is located at that point,rather than the top-left corner.
\end{textblock}
\begin{textblock}{3,4}(6,4)
The dimensions of this block are 3$\times$4 cm.
Its origin is position (6,4) on the page. Note that the text
overflows the margin in some cases; you'll want to
use the \texttt{minipage} environment to prevent that.
\end{textblock}
\end{document}

17 A.5: How to write a poster

B2P 32 Markdown¥} Pandoc oA

(o] B A7} 715k E).) 2.4 A 271513 1= Pandoc HEH7| £ 0]-83}= Mark-

down oA & =22 2Mdst= MES AlEtth. sig 2o HE

ilo
go
()
»
o
In)

title: |
=S 7|0l H=Cf: \
HEE & & 0|4 S W
author: Guido Gonzato
date: 20184 1g¥
documentclass: oblivoir
papersize: b5paper
fontsize: 1lpt
classoption: gremph
numbersections: true
header-includes: |
\usepackage{fapapersize}
\usefapapersize{*,*,30mm,50mm,25mm, *}
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\ifLuaOrXeTeX
\setkomainfont(Noto Serif CJK KR) (* Bold) (Noto Sans CJK KR Light)
\fi
abstract: |
29%FS 7|0 Ho{&2}.

<i--- AMEL O/ WHOE HojgZ -->

# M4 8
2248 *+BE 2T 4 ULt
#7129 (italic)* 2= 7H58tH| 820 of

Alfst=5 2YsloF stot. O7|M= LHHE

HYSHAUCH. Yot HAEE 1Y 22 MY

(]
35 93 AOB [OfXT 4 M] (#theend) 2
# NEMA
‘verbatim text'E MEE £ QLC}.
# OFR|SH MM {#theend}
OFHR| A M ZEStA|I 7| E:
> 0|21, pandocO] O} HRE|| OIUATILI!
2|9 2|2 pandocO| UZA|.

<!l--- end of pandoc_ template ko.md -->

2 S AE oblivoirZ 3HtH HEL article =A17F ©t}. header-includes
H2olA oblivoirg 913t A7 o] Eof o B & thE #A] SejAe o] 25 s S
20| FE & L5k A Y A Qg

Pandoc S Z pdf ¥Zste]H of& B & W=,

shell> pandoc --toc --pdf-engine=xelatex \

pandoc_template ko.md -o pandoc_ template ko.pdf

--pdf-engines xelatex 22 A Qs o] AL X]7} §lo™ pdflatex 2= FHutd
s},

YAML header2] numbersections: = Ao HS & Holgl= Zlojth HH3Y A
OF --number-sections AAE Fol& 2 AiE A=t} Pandoc?] 7|23k AlM

M2 E Alsh= Aol
gkeF TOC7} 8 2 51thH Pandoc A3 & L2 - -tocstH &5ttt
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